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                                                    ΠΡΟΛΟΓΟΣ 

Κάθε κατασκευή, πριν πραγματοποιηθεί, αποτυπώνεται σε χαρτί, δίνοντας μια 
πρώτη εικόνα και δυνατότητα ελέγχου του τελικού αποτελέσματος.   Όσοι 
συμμετέχουν στο σχεδιασμό ενός κατασκευαστικού έργου πρέπει να ξέρουν 
να δημιουργούν και να διαβάζουν σχέδια. 

Η σχεδιαστική διαδικασία είχε παραμείνει αναλλοίωτη για μεγάλο μέρος της 
ανθρώπινης ιστορίας. Τα εργαλεία για την πραγματοποίηση ενός σχεδίου 
ήταν το μολύβι, ο χάρακας, το ταυ με το τρίγωνο και ο παραλληλογράφος.  
Πριν την εμφάνιση των σχεδιαστικών προγραμμάτων στον ηλεκτρονικό 
υπολογιστή, οι σχεδιαστές χρειάζονταν ατέλειωτες ώρες, επαναλαμβάνοντας 
με το χέρι τα σχέδια για την παραμικρή αλλαγή.    

Η εξέλιξη τόσο των υπολογιστών, όσο και των σχεδιαστικών προγραμμάτων, 
άλλαξαν δραματικά τον τρόπο σχεδίασης.  Η σχεδίαση με βάση τον 
ηλεκτρονικό υπολογιστή άρχισε να εφαρμόζεται από τις αρχές της δεκαετίας 
του ’70.  Χρόνο με το χρόνο, το κόστος της σχεδίασης με υπολογιστή έπεφτε, 
ενώ οι δυνατότητες αυξάνονταν εντυπωσιακά. 

Σήμερα, δύσκολα θα συναντήσουμε επαγγελματία που δεν χρησιμοποιεί ή 
δεν προγραμματίζει να χρησιμοποιήσει υπολογιστή για τα σχέδιά του.   

Η χρήση ενός σχεδιαστικού πακέτου στον ηλεκτρονικό υπολογιστή προσφέρει 
μια πληθώρα πλεονεκτημάτων στη δουλειά μας: 

• Εξοικονόμηση χρόνου:  Η ευκολία σχεδίασης ενός αντικειμένου είναι 
εντυπωσιακή, σε σχέση με την αντίστοιχη διαδικασία με το χέρι.  Κάθε 
μετέπειτα τροποποίηση του σχεδίου γίνεται άμεσα, αφού ασχολούμαστε 
μόνο με το συγκεκριμένο μέρος του σχεδίου που θέλουμε να αλλάξουμε. 

• Εξοικονόμηση κόστους: Το οικονομικό όφελος είναι μεγάλο από την 
ολοκλήρωση των σχεδίων σε πολύ λιγότερο χρόνο, δίνοντας μας τη 
δυνατότητα να αναλάβουμε ταυτόχρονα και άλλα έργα.  Η απόσβεση της 
αρχικής επένδυσης για την αγορά του ηλεκτρονικού υπολογιστή (που 
πιθανώς ήδη να υπάρχει για άλλη χρήση) και του σχεδιαστικού 
προγράμματος, γίνεται μέσα σε ιδιαίτερα σύντομο χρονικό διάστημα, 
αντιστρόφως ανάλογο του όγκου της σχεδίασης. 

• Ακρίβεια και λεπτομέρεια σχεδίασης:  Η σχεδίαση με ηλεκτρονικό 
υπολογιστή δίνει τη δυνατότητα για απόλυτη ακρίβεια στα σχέδιά μας, 
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αποφεύγοντας έτσι πιθανά λάθη ή αβλεψίες με μεγάλο τίμημα σε 
μεταγενέστερο στάδιο.  Η σχεδίαση μπορεί να γίνει σε οποιοδήποτε 
επίπεδο λεπτομέρειας θέλουμε, ακόμη και σταδιακά. 

• Άντληση πληροφοριών:  Η σχεδίαση με ηλεκτρονικό υπολογιστή δίνει, 
επιπλέον, τη δυνατότητα να αντλούμε  ακριβείς πληροφορίες από το σχέδιο 
για επιμετρήσεις, εμβαδομετρήσεις κλπ. 

• Ευελιξία και συνεργασία:  Με τη χρήση ενός σχεδιαστικού προγράμματος 
και ειδικότερα κάποιου από τα πιο διαδεδομένα στην αγορά, το σχέδιό μας 
μπορεί να μοιραστεί μεταξύ πολλών συνεργατών για συμπλήρωση και 
έλεγχο. 

• Τελικό προϊόν:  Μια κατασκευή σχεδιασμένη με ηλεκτρονικό υπολογιστή 
μπορεί να απεικονίσει σε πλήρη λεπτομέρεια την τελική του μορφή, πολύ 
πριν κατασκευαστεί στην πραγματικότητα. Μπορούμε εύκολα να έχουμε 
πολλές παραλλαγές του τελικού αποτελέσματος, για να αποφασίσουμε 
ποια ικανοποιεί καλύτερα τις ανάγκες μας. 

Είναι πλέον σαφές ότι, έτσι, τα κατασκευαστικά έργα σχεδιάζονται πολύ πιο 
γρήγορα και σωστά, δίνοντάς μας τη δυνατότητα να επικεντρωθούμε 
περισσότερο στην αξιοποίηση του αντικειμένου παρά στην διαδικασία 
σχεδίασής του. 
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 8 



 
                                  ΕΙΔΗ ΑΡΧΕΙΩΝ ΣΧΕΔΙΩΝ 
 
    Τα σχεδιαστικά προγράμματα χωρίζονται σε δυο κατηγορίες, ανάλογα με 
τον τρόπο που χειρίζονται τα στοιχειώδη αντικείμενα σχεδιασμού. 
 

• Διανυσματικά (vector) :Σχεδιάζουμε γεωμετρικά σχήματα, τα οποία 
προσδιορίζονται από τα βασικά τους χαρακτηριστικά π.χ. σε ένα 
ευθύγραμμο τμήμα, τις συντεταγμένες αρχής και τέλους. Για αυτό το 
λόγο   μπορούμε εύκολα τους αλλάζουμε το μέγεθος ,δίχως απώλειες 
στην ποιότητα του σχεδίου. 

• Χαρτογραφικά (bitmap): Η γραμμή αποτελείται από πολλούς 
κόκκους. Για κάθε κόκκο πρέπει να υπάρχουν τα χαρακτηριστικά του 
(συντεταγμένες, χρώμα κ.τ.λ. ). Σε περίπτωση μεγέθυνσης του 
αρχείου, δεν υπάρχουν τα απαραίτητα στοιχεία για τα ενδιάμεσα 
σημεία, οπότε το σχέδιο χάνει σε ευκρίνεια.    

 
     Τα προγράμματα τεχνικού σχεδίου είναι διανυσματικά. Καταλαμβάνουν 
έτσι λιγότερο χώρο στον σκληρό δίσκο, αλλά και οι διαστάσεις τους και οι 
κλίμακες μπορούν να αλλάξουν ποιο εύκολα χωρίς απώλειες.  
     
      Τις φωτογραφίες, επειδή δεν μπορούμε εύκολα να τις αποδώσουμε με 
γραμμές και κύκλους, τις επεξεργαζόμαστε με χαρτογραφικά προγράμματα 
Εκεί για την ευκρίνεια παίζουν ποιο  πολύ ρόλο η ανάλυση (πόσοι κόκκοι 
υπάρχουν) και το πλήθος των χρωμάτων.  
 
Στην εξήγηση των εντολών χρησιμοποιούνται τα παρακάτω σύμβολα: 

 

  Line Περιγράφει το όνομα μιας εντολής, καθώς και το σύμβολο του 
εργαλείου που επιλέγουμε με το ποντίκι στην οθόνη. 

 Γράφουμε την εντολή στο πληκτρολόγιο. 

  Εκτελούμε την εντολή από ένα μενού με το ποντίκι. 
 ┘ Περιγράφει το Εnter 

 Περιέχει συμβουλή ή παρατήρηση, στην οποία πρέπει να 
δώσουμε ιδιαίτερη προσοχή. 

  

Τα προγράμματα σχεδίασης με ηλεκτρονικό υπολογιστή είναι ιδιαίτερα 

σύνθετα εργαλεία και παρέχουν πάρα πολλές δυνατότητες και ευκολίες 

χειρισμού. 

 

Εκτός από τις γνώσεις για τη λειτουργία των σχεδιαστικών προγραμμάτων 

που μπορεί να αποκτηθούν σε ένα μάθημα, είναι σημαντική και η πείρα που 
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έχουμε πάνω στον χειρισμό του προγράμματος.  Η ταχύτητα της εργασίας 

μας εξαρτάται σε μεγάλο βαθμό από το χρόνο, κατά τον οποίο έχουμε 

δουλέψει με ένα πρόγραμμα.  Με το χρόνο, μαθαίνουμε να χρησιμοποιούμε  

τη σωστή αλληλουχία εντολών κατά περίπτωση και έτσι η δουλειά μας γίνεται 

όλο και πιο επινοητική και δημιουργική. Έτσι, μπορούμε να έχουμε το ίδιο 

αποτέλεσμα με πολλούς διαφορετικούς τρόπους, τόσους όσοι είναι και οι 

χρήστες. 
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ΠΕΡΙΒΑΛΛΟΝ 

 

 

 

 

 

1. ΕΚΚΙΝΗΣΗ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ  

2. ΠΙΝΑΚΑΣ ΕΚΚΙΝΗΣΗΣ 

3. ΟΘΟΝΗ ΣΧΕΔΙΑΣΗΣ  

4. ΤΟ ΠΟΝΤΙΚΙ 

5. ΔΙΑΧΕΙΡΙΣΗ ΑΡΧΕΙΩΝ 
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1.1  ΕΚΚΙΝΗΣΗ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 
 
Το σχεδιαστικό μας πρόγραμμα ξεκινά με δύο τρόπους: 

 
1.  Με την ένδειξη Start στην επιφάνεια εργασίας.  Ακολούθως 

 επιλέγουμε την ένδειξη Programs και στην ενότητα του  
προγράμματος, επιλέγουμε τον τίτλο του.  

 
 
 

2.  Με το εικονίδιο συντόμευσης στην επιφάνεια εργασίας των Windows. 
 

 
Οι δύο τρόποι έχουν το ίδιο αποτέλεσμα:  Το πρόγραμμα εμφανίζεται στην 

οθόνη του υπολογιστή. 

 
1.2 Ο ΠΙΝΑΚΑΣ ΕΚΚΙΝΗΣΗΣ (STARTUP) 
 
Όταν αρχίζουμε το πρόγραμμα, το πρώτο πράγμα που εμφανίζεται στην 
οθόνη μας είναι ο πίνακας εκκίνησης (Startup).  Στον πίνακα αυτό έχουμε 
τέσσερις τρόπους, με τους οποίους μπορούμε να αρχίσουμε να δουλεύουμε. 
 

 
1. 1  ΠΙΝΑΚΑΣ STARTUP 

 
Με το Startup, μπορούμε:  
 
1. 

 
(Open a Drawing) Να ανοίξουμε ένα παλιό σχέδιο. 

2. 
 

(Start from Scratch) Να αρχίσουμε χωρίς αρχικές ρυθμίσεις. 

3. 
 

(Use a Template) Να αρχίσουμε ένα νέο σχέδιο με 
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συγκεκριμένο υπόβαθρο. 
4. 

 
(Use a Wizard) Να αρχίσουμε ένα νέο σχέδιο με 

καθοδήγηση. 
 
 
 
1.2.1  Open a Drawing 
 

 
1. 2  ΠΙΝΑΚΑΣ OPEN A DRAWING 

 
Με την επιλογή αυτή ανοίγει ένας πίνακας, από τον οποίο μπορούμε να 

επιλέξουμε ένα παλιό, υπάρχον, σχέδιο που θέλουμε να ανοίξουμε.  Στην 

αριστερή πλευρά του πίνακα βλέπουμε ένα κατάλογο των σχεδίων του 

τρέχοντος φακέλου. Κάθε φορά που δείχνουμε με το ποντίκι το όνομα ενός 

σχεδίου, βλέπουμε την εικόνα του στη δεξιά πλευρά του πίνακα. Τέλος, αν 

πιέσουμε την ένδειξη Open, ανοίγει το σχέδιο που έχουμε επιλέξει. 

 
1.2.2 Start from Scratch 

 
1.3 ΠΙΝΑΚΑΣ START FROM SCRATCH 
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Η επιλογή αυτή δημιουργεί ένα νέο σχέδιο με τις βασικές ρυθμίσεις του 
προγράμματος, όπως τις έχουν καθορίσει οι δημιουργοί του.  Η μόνη 
δυνατότητα που έχουμε, είναι να αποφασίσουμε για το σύστημα μέτρησης 
 
 
που θα χρησιμοποιήσουμε.  Συνήθως επιλέγουμε το μετρικό σύστημα 

(Metric).  Πιέζουμε με το ποντίκι την ένδειξη Metric και τελειώνουμε με το ΟΚ. 

 
1.2.3  Use a Template 

 
1. 4 ΠΙΝΑΚΑΣ USE A TEMPLATE 

 
Όταν αρχίζουμε ένα νέο σχέδιο, μπορούμε να δουλέψουμε με κάποιο 

υπόβαθρο (Template).  Το υπόβαθρο είναι ένα αρχείο που περιέχει έτοιμα 

στοιχεία και ρυθμίσεις για το σχέδιό μας.   

Ο κατάλογος όλων των υποβάθρων εμφανίζεται στην αριστερή πλευρά της 

οθόνης.  Όταν επιλέγουμε ένα με το ποντίκι, βλέπουμε την εικόνα του δεξιά.  

Αν δεν βρίσκουμε το υπόβαθρο που θέλουμε μέσα στον κατάλογο, πιέζουμε 

την ένδειξη Browse για να αναζητήσουμε το αρχείο στα περιεχόμενα του 

υπολογιστή μας.  

Τέλος, αν πιέσουμε το ΟΚ, αρχίζει νέα σχεδιαστική φάση, με βάση το 

υπόβαθρο που επιλέξαμε. 

1.2.4  Use a Wizard 
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1.5 ΠΙΝΑΚΑΣ USE A WIZARD 

 
Μπορούμε να αρχίσουμε ένα νέο σχέδιο με μερικές ελάχιστες ρυθμίσεις.  

Αυτές θα μας διευκολύνουν στην πορεία του σχεδίου. 

Το πρόγραμμα διαθέτει ένα οδηγό που μας καθοδηγεί στα βήματα που 

χρειάζονται για να ρυθμίσουμε το σχέδιο.  Μπορούμε να κάνουμε μία γρήγορη 

ρύθμιση (Quick Setup) ή μία προχωρημένη (Advanced Setup).  
 
1.2.4.1  Quick Setup (Γρήγορη Ρύθμιση) 

Η γρήγορη ρύθμιση αποτελείται από δύο βήματα: 

1.2.4.1.1   Units (Μονάδες Μέτρησης) 

 
1. 6 ΠΙΝΑΚΑΣ QUICK SETUP UNITS 
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Στο πρώτο βήμα επιλέγουμε τη μονάδα μέτρησης.  Έχουμε διαθέσιμες 

επιλογές, όπως πόδια και ίντσες ή κλάσματα.   Συνήθως επιλέγουμε το 

δεκαδικό σύστημα (Decimal).  
 
1.2.4.1.2  Area (Περιοχή Σχεδίασης) 

 
1. 7 ΠΙΝΑΚΑΣ QUICK SETUP AREA 

 
 
Το δεύτερο βήμα καθορίζει τα όρια 

της περιοχής σχεδίασης.  Στο πεδίο 

Width πληκτρολογούμε το πλάτος 

της και στο πεδίο Length το ύψος 

της. 

WIDTH

H
EI

G
H

T

 
1. 8 ΠΛΑΤΟΣ ΚΑΙ ΥΨΟΣ ΦΥΛΛΟΥ 

 
 

 Οι δύο αριθμοί που πληκτρολογούμε  εξαρτώνται  από την κλίμακα 
εκτύπωσης του σχεδίου.  Στην περιγραφή της εντολής Drawing 
Limits (Όρια της Σχεδιαστικής Περιοχής), παρουσιάζεται 
αναλυτικός πίνακας για τα μεγέθη των χαρτιών σε σχέση με την 
κλίμακα εκτύπωσης.  Για αρχή, μπορούμε να χρησιμοποιήσουμε 
τους αριθμούς:  Width = 42, Length = 29.7. 

 
   

Με το πλήκτρο Finish ολοκληρώνονται οι ρυθμίσεις.  
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1.2.4.2  Advanced Setup (Προχωρημένη Ρύθμιση) 

Η προχωρημένη ρύθμιση αποτελείται από πέντε βήματα: 
 
1.2.4.2.1  Units (Μονάδες Μέτρησης Μήκους) 

 
1.9 ΠΙΝΑΚΑΣ ADVANCED SETUP UNITS 

 
Το πρώτο βήμα είναι ίδιο με αυτό της απλής ρύθμισης.  Επιπλέον, όμως, μας 

επιτρέπει να ορίσουμε την ακρίβεια, με την οποία θα εμφανίζονται τα 

γραμμικά μεγέθη (πόσα δεκαδικά ψηφία θα μας δείχνει).  Η ακρίβεια 

ρυθμίζεται στον κατάλογο Precision.  
 

 Η ακρίβεια που θα επιλέξουμε εξαρτάται από το θέμα μας.  Π.χ. για 
κατασκευαστικό, επιλέγουμε συχνά ακρίβεια δύο ψηφίων:  0.00.  
Αν σχεδιάζουμε ένα έπιπλο, μπορεί να επιλέξουμε τρία ψηφία: 
0.000.  

 
 

1.2.4.2.2 Angle (Μονάδες Μέτρησης Γωνίας) 

 
1. 10 ΠΙΝΑΚΑΣ ADVANCED SETUP ANGLE 
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Μπορούμε να μετρούμε τις γωνίες με μοίρες, βαθμούς, ακτίνια κ.α.  Ο πίνακας 

αυτός καθορίζει τη μονάδα μέτρησης της γωνίας, καθώς και την ακρίβεια, με 

την οποία θα εμφανίζονται τα γωνιακά μεγέθη.  Συνήθως επιλέγουμε 

δεκαδικές μοίρες (Decimal Degrees) και ακρίβεια 0.0. 

 
1.2.4.2.3  Angle Measure (Αφετηρία Μέτρησης Γωνιών) 

 
1.11 ΠΙΝΑΚΑΣ ADVANCED SETUP ANGLE MEASURE 

 
Το τρίτο βήμα καθορίζει την αφετηρία  

μέτρησης των γωνιών, δηλαδή την 

κατεύθυνση της γωνίας μηδέν.  Οι λέξεις 

East (Ανατολή), North (Βορράς), West 
(Δύση) και South (Νότος) είναι οι τέσσερις 

βασικές κατευθύνσεις. Η προκαθορισμένη 

κατεύθυνση είναι η Ανατολή. 

Αν θέλουμε μία άλλη κατεύθυνση, 

επιλέγουμε την Other (Άλλη) και 

πληκτρολογούμε τη νέα κατεύθυνση στο 

πεδίο. 

0

90

180

270

45135

225 315

1. 12 ΜΕΤΡΗΣΗ ΓΩΝΙΑΣ 
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1.2.4.2.4  Angle Direction (Κατεύθυνση Θετικής Φοράς των Γωνιών) 

 
1.13 ΠΙΝΑΚΑΣ ADVANCED SETUP ANGLE DIRECTION 

 
 

Στο βήμα αυτό, επιλέγουμε τη φορά 

της θετικής μέτρησης των γωνιών.  

Μπορούμε να μετρούμε τη γωνία 

αριστερόστροφα (Counter-Clockwise) 

ή δεξιόστροφα (Clockwise).  Συνήθως 

χρησιμοποιούμε αριστερόστροφη 

φορά.  

 

0

90

180

270

45135

225 315

+

 

1. 14 ΚΑΤΕΥΘΥΝΣΗ ΘΕΤΙΚΗΣ 
ΦΟΡΑΣ ΓΩΝΙΑΣ 
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1.2.4.2.5  Area (Περιοχή Σχεδίασης) 

Το πέμπτο βήμα καθορίζει τα όρια της περιοχής σχεδίασης και είναι ίδιο σε 

λειτουργία, με το αντίστοιχο βήμα της γρήγορης ρύθμισης του σχεδίου. 
1.3  ΟΘΟΝΗ ΣΧΕΔΙΑΣΗΣ 
 
Όταν έχουμε ολοκληρώσει τη διαδικασία της εκκίνησης του σχεδίου,  

εμφανίζεται η οθόνη του προγράμματος.  Παρακάτω φαίνονται οι περιοχές 

της: 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

COMMAND LINE (ΠΕΡΙΟΧΗ ΕΝΤΟΛΩΝ / ΕΠΙΚΟΙΝΩΝΙΑΣ) 

ΤΙΤΛΟΣ ΤΟΥ ΠΡΟΓΡΑΜΜΑΤΟΣ 
 

PULL DOWN MENU (ΠΤΥΣΣΟΜΕΝΟ ΜΕΝΟΥ) 

DOCKED TOOLBAR (ΣΤΑΘΕΡΟΠΟΙΗΜΕΝΗ ΟΜΑΔΑ ΕΡΓΑΛΕΙΩΝ) 

FLOATING TOOLBAR (ΚΙΝΗΤΗ ΟΜΑΔΑ ΕΡΓΑΛΕΙΩΝ) 

ΟΝΟΜΑ ΣΧΕΔΙΟΥ 

ΣΤΑΥΡΟΝΗΜΑ 

UCS ICON (ΕΙΚΟΝΙΔΙΟ ΣΥΣΤΗΜΑΤΟΣ ΣΥΝΤΕΤΑΓΜΕΝΩΝ) 

SCROLL BARS (ΛΩΡΙΔΑ ΚΥΛΙΣΗΣ) 

ΠΕΡΙΟΧΗ ΣΧΕΔΙΟΥ 
 

STATUS BAR (ΓΡΑΜΜΗ ΚΑΤΑΣΤΑΣΗΣ) 

COORDINATES (ΣΥΝΤΕΤΑΓΜΕΝΕΣ) 
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1. 15 Η ΟΘΟΝΗ ΣΧΕΔΙΑΣΗΣ 

 
Οι δύο πιο σημαντικές περιοχές της οθόνης είναι η Περιοχή Σχεδίου και η 

Γραμμή Εντολών .   

 
1.3.1   Περιοχή Σχεδίασης (Drawing Area) 
 
Η περιοχή σχεδίασης αποτελεί το μεγαλύτερο μέρος της οθόνης και μπορεί 

να περιέχει ένα ή περισσότερα σχέδια.  Μέσα στην περιοχή σχεδίασης κινείται 

το σταυρόνημα καθώς μετακινούμε το ποντίκι.  Στην κάτω αριστερή γωνία 

εμφανίζεται το εικονίδιο του συστήματος συντεταγμένων (UCS Icon), το 

οποίο μας ενημερώνει για τις θετικές κατευθύνσεις των αξόνων Χ και Υ.   

 
1.3.2  Η Γραμμή Εντολών (Command Line)   

Η γραμμή εντολών είναι ιδιαίτερα σημαντική κατά τη διάρκεια της σχεδίασης.  

Γενικά η σχεδίαση γίνεται πολύ πιο εύκολη αν προσέχουμε τα μηνύματα και 

τις προτροπές της περιοχής αυτής.  Στη γραμμή εντολών: 

• πληκτρολογούμε τις εντολές του προγράμματος με το όνομά τους ή τη 
συντόμευσή τους. 

  
• εμφανίζονται οι επιλογές, με τους τρόπους εκτέλεσης της κάθε εντολής. 

• εμφανίζονται οι οδηγίες και οι προτροπές προς το χρήστη.  

• εμφανίζονται προειδοποιήσεις και μηνύματα για τυχόν λάθη που έχουμε 
κάνει. 

 

1.3.3  Οι Ομάδες Εργαλείων (Toolbars)  

Οι ομάδες εργαλείων περιέχουν εικονίδια που αντιστοιχούν σε εντολές του 

προγράμματος.  Μπορούμε να εμφανίσουμε ή να κρύψουμε τις ομάδες που 

θέλουμε.  Με τον τρόπο αυτό, διαμορφώνουμε το περιβάλλον εργασίας 

σύμφωνα με τις απαιτήσεις μας. 
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1.3.4 Το Πτυσσόμενο Μενού (Pull-Down Menu)  

Το πτυσσόμενο μενού περιέχει ενότητες με επιλογές που αντιστοιχούν σε 

εντολές του προγράμματος.  Οι περισσότερες εντολές βρίσκονται συγχρόνως 

και εδώ και στα Toolbars. 

1.3.5  Η Γραμμή Κατάστασης (Status Bar) 

Στη γραμμή κατάστασης εμφανίζονται πλαίσια που δείχνουν και μπορούν να 

αλλάξουν την κατάσταση μερικών ρυθμίσεων που χρησιμοποιούνται συχνά. 

Αριστερά εμφανίζονται οι συντεταγμένες που αντιστοιχούν στην τρέχουσα 

θέση του σταυρονήματος, καθώς αυτό κινείται στη σχεδιαστική επιφάνεια.   

 
1.36  Οι Λωρίδες Kύλισης (Scroll Bars) 

Οι λωρίδες κύλισης κινούν την εικόνα του σχεδίου μας πάνω στην οθόνη. 

 
1.4  ΤΟ ΠΟΝΤΙΚΙ 

ΠΟΝΤΙΚΙ
ΜΕ 2 ΠΛΗΚΤΡΑ

ΠΟΝΤΙΚΙ
ΜΕ 3 ΠΛΗΚΤΡΑ

ΠΟΝΤΙΚΙ
ΜΕ ΡΟΔΑ  

1. 16 ΤΡΙΑ ΕΙΔΗ ΠΟΝΤΙΚΙΩΝ 
Με το ποντίκι μπορούμε να επιλέγουμε εντολές και να σχεδιάζουμε γραμμές 

στην οθόνη. 

 
Υπάρχουν τρία είδη ποντικιών: 

• Ποντίκι με δύο πλήκτρα 

• Ποντίκι με τρία πλήκτρα. 

• Ποντίκι με δύο πλήκτρα και ρόδα. 

 
Όταν έχουμε ποντίκι με δύο πλήκτρα, το αριστερό επιλέγει εντολές από 

μενού ή ομάδα εργαλείων και προσδιορίζει σημεία πάνω στη σχεδιαστική 
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επιφάνεια.  Το δεξιό πλήκτρο μπορεί να εμφανίσει ένα σύντομο μενού με 

επιλογές ή να κάνει ό,τι και το ENTER ( ή το SPACEBAR στο 

πληκτρολόγιο.   

 

 

1.5  ΔΙΑΧΕΙΡΙΣΗ ΑΡΧΕΙΩΝ 
 
Με το σχεδιαστικό πρόγραμμα μπορούμε να δημιουργούμε νέα σχέδια ή να 

επεξεργαζόμαστε παλιά.  Μπορούμε να αποθηκεύουμε τη δουλειά μας, να 

αντιγράφουμε σχέδια και να τα κλείνουμε. 

 

Το σχεδιαστικό πρόγραμμα διαχειρίζεται τα αρχεία του σύμφωνα με τα 

πρότυπα του λειτουργικού μας συστήματος.  Οι εντολές διαχείρισης αρχείων 

εμφανίζονται στο πτυσσόμενο μενού στην κατηγορία File.  Μερικές από αυτές 

βρίσκονται και στη Standard Toolbar, στο πάνω μέρος της οθόνης. 

 

 
1. 17 Η STANDARD TOOLBAR 

 
1.5.1     New 
 
Η εντολή NEW αρχίζει ένα νέο σχέδιο.  Εμφανίζει το γνωστό πίνακα του Start 

Up για να επιλέξουμε τη μέθοδο εκκίνησης που θέλουμε να 

χρησιμοποιήσουμε.   

 
 Command Line:  New  
 Pull-down Menu:  File  → New  
 
1.5.2    Open 
 
Η εντολή OPEN ανοίγει ένα παλιό σχέδιο.  
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1. 18 O ΠΙΝΑΚΑΣ ΕΠΙΛΟΓΗΣ ΣΧΕΔΙΟΥ 

 
 Command Line:   Open ┘ 
 Pull-down Menu:  File → Open  
 
Επιλέγουμε το σχέδιο που θέλουμε να ανοίξουμε από τον πίνακα Select File.  

Στη δεξιά πλευρά του πίνακα βλέπουμε μία εικόνα του σχεδίου.  Αν πιέσουμε 

το Open, ανοίγει το σχέδιο που έχουμε επιλέξει. 

 
 
1.5.3     Quick Save 
 
Η εντολή QSAVE αποθηκεύει ένα σχέδιο στο δίσκο του υπολογιστή μας. 

 Command Line:  Qsave ┘ 
 Pull-down Menu:  File → Save  
 
Αν χρησιμοποιήσουμε την εντολή για πρώτη φορά, πρέπει να δώσουμε ένα 

όνομα στο σχέδιο.  Εμφανίζεται ο παρακάτω πίνακας:   
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1. 19 Ο ΠΙΝΑΚΑΣ SAVE DRAWING AS 

 
Στο πεδίο File name πληκτρολογούμε το όνομα του σχεδίου.   Τις επόμενες 

φορές που θα χρησιμοποιούμε την ίδια εντολή, το πρόγραμμα αποθηκεύει το 

σχέδιο κατευθείαν.  

1.5.4  Save As 
 
Η εντολή SAVEAS αποθηκεύει ένα αντίγραφο του σχεδίου μας με νέο όνομα.  

Χρησιμοποιεί τον ίδιο πίνακα με την εντολή Save.  Μπορούμε, με την εντολή 

αυτή, να δημιουργήσουμε πολλά αντίγραφα του ίδιου σχεδίου, δίνοντας κάθε 

φορά και νέο όνομα.  Το πρόγραμμα αυτομάτως κλείνει το παλιό σχέδιο και 

ανοίγει το νέο. 
 Command Line:  Saveas ┘ 
 Pull-down Menu:  File  →Save As 
 
1.5.5  Close 
 
Η εντολή CLOSE κλείνει ένα σχέδιο, το οποίο είχαμε ανοίξει, ενώ το 

πρόγραμμα παραμένει ανοιχτό. 

 
 Command Line:  Close ┘ 
 Pull-down Menu:  File → Close  
 
Αν προσπαθήσουμε να κλείσουμε ένα σχέδιο, χωρίς να το έχουμε 

προηγουμένως φυλάξει, εμφανίζεται η παρακάτω προειδοποίηση (Θέλεις να 

φυλάξεις τις αλλαγές του σχεδίου;):   
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1.20  ΠΡΟΕΙΔΟΠΟΙΗΣΗ ΤΗΣ ΕΝΤΟΛΗΣ CLOSE 

 

Αν θέλουμε να φυλάξουμε τη δουλειά που έχουμε κάνει στο σχέδιο, 

επιλέγουμε το Yes και αν δεν θέλουμε, πιέζουμε το No.  Τέλος,  αν θέλουμε 

να ακυρώσουμε το κλείσιμο του σχεδίου, πιέζουμε το Cancel. 
 
1.5.6  Exit 
 
Η εντολή EXIT κλείνει το σχεδιαστικό πρόγραμμα και μας επιστρέφει στο 

λειτουργικό σύστημα.  

 
 Command Line:  Exit ┘ 
 Pull-down Menu:  File  →Exit  
Αν δεν έχουμε προηγουμένως φυλάξει τη δουλειά των σχεδίων μας, 

εμφανίζεται ο παραπάνω πίνακας προειδοποίησης, την οποία έχουμε την 

ευκαιρία να φυλάξουμε ή να απορρίψουμε. 
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2 

ΒΑΣΙΚΟΙ ΚΑΝΟΝΕΣ ΧΕΙΡΙΣΜΟΥ 

 

 

 

 

 

 

 

 

1. ΧΕΙΡΙΣΜΟΣ ΕΝΤΟΛΩΝ ΣΤΗ ΓΡΑΜΜΗ ΕΝΤΟΛΩΝ 

2. ΕΠΙΛΟΓΗ ΕΝΤΟΛΩΝ ΑΠΟ ΤΟ ΠΤΥΣΣΟΜΕΝΟ ΜΕΝΟΥ 

3. ΔΙΑΧΕΙΡΙΣΗ ΟΜΑΔΩΝ ΕΡΓΑΛΕΙΩΝ 
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2.1   ΧΕΙΡΙΣΜΟΣ ΕΝΤΟΛΩΝ ΣΤΗ ΓΡΑΜΜΗ ΕΝΤΟΛΩΝ 

Στο σχεδιαστικό πρόγραμμα μπορούμε να αρχίζουμε μία εντολή με ποικίλους 

τρόπους:  

• μπορούμε να την πληκτρολογήσουμε στη γραμμή εντολών (Command 
Line), 

  
• μπορούμε να την επιλέξουμε από το πτυσσόμενο μενού, 
  
• μπορούμε να την επιλέξουμε από ένα εργαλείο.  

Μπορούμε να αρχίσουμε όλες τις εντολές πληκτρολογώντας τις στη γραμμή 

εντολών.  

Πρώτα, όμως, πρέπει να ελέγξουμε τη γραμμή και να δούμε αν είναι έτοιμη να 

δεχτεί νέα εντολή.  Το πρόγραμμα μπορεί να δεχτεί νέα εντολή όταν στην 

τελευταία σειρά εμφανίζεται η λέξη Command:. 

 
1. 21  Η ΓΡΑΜΜΗ ΕΝΤΟΛΩΝ 

Αν το πρόγραμμα είναι έτοιμο να δεχτεί εντολή, πληκτρολογούμε το όνομα της 

εντολής και στη συνέχεια πάντα πιέζουμε το ENTER ( Το ENTER 

λειτουργεί σαν επιβεβαίωση της πληκτρολόγησης.   

 
Για παράδειγμα, για να αρχίσουμε να σχεδιάζουμε γραμμή, πληκτρολογούμε 

την εντολή LINE και πιέζουμε το ENTER(┘)   Το περιεχόμενο της γραμμής 

εντολών αλλάζει και εμφανίζονται τα μηνύματα για την τρέχουσα εντολή. 

Command: Line ┘ 
Specify first point: αρχίζουν οι οδηγίες της εντολής. 

 
Είναι πολύ σημαντικό να προσέχουμε τα μηνύματα αυτά. 
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2.2  ΕΠΙΛΟΓΗ ΕΝΤΟΛΩΝ ΑΠΟ ΤΟ ΠΤΥΣΣΟΜΕΝΟ ΜΕΝΟΥ 
 
Το πτυσσόμενο μενού περιέχει πολλές κατηγορίες εντολών: 

File Περιέχει εντολές διαχείρισης των σχεδίων. 
Edit Περιέχει εντολές επεξεργασίας του λειτουργικού συστήματος. 
View Περιέχει εντολές διαχείρισης της οθόνης. 
Insert Περιέχει εντολές εισαγωγής αντικειμένων. 
Format Περιέχει εντολές μορφοποίησης και ρύθμισης του σχεδίου.  
Tools Περιέχει εντολές βοηθητικών εργαλείων. 
Draw Περιέχει εντολές σχεδίασης νέων αντικειμένων. 
Dimension Περιέχει εντολές διαστασιολόγησης. 
Modify Περιέχει εντολές τροποποίησης.  
Express Περιέχει πρόσθετες εντολές αυτοματοποίησης. 
Window Περιέχει εντολές διαχείρισης των παραθύρων των σχεδίων. 
Help Περιέχει εντολές βοήθειας.  
 
 

2.3       ΔΙΑΧΕΙΡΙΣΗ ΤΩΝ ΟΜΑΔΩΝ ΕΡΓΑΛΕΙΩΝ  
 
  

 

Μπορούμε να επιλέγουμε μία εντολή από τις 

ομάδες εργαλείων.   Το αποτέλεσμα θα είναι το 

ίδιο αν την πληκτρολογήσουμε στη γραμμή 

εντολών ή αν την επιλέξουμε από το 

πτυσσόμενο μενού.   Για παράδειγμα, η εντολή 

Line εμφανίζεται στην ομάδα εργαλείων Draw 

(αρχικά στην αριστερή άκρη της οθόνης). 

Το πρόγραμμα διαθέτει πολλές ομάδες 

εργαλείων, αλλά δεν τις παρουσιάζει όλες, 

εξαρχής, στην οθόνη.  Αν θέλουμε να 

χρησιμοποιήσουμε μία ομάδα που δεν φαίνεται 

αρχικά στην οθόνη, τότε πιέζουμε το δεξιό μας 

πλήκτρο πάνω σε οποιοδήποτε εργαλείο.  

Αμέσως εμφανίζεται ο κατάλογος των 

διαθέσιμων ομάδων.  Με το αριστερό πλήκτρο 

του ποντικιού, επιλέγουμε την ενότητα που 

θέλουμε.  Αμέσως αυτή εμφανίζεται στην οθόνη.  

 
1. 22 ΑΡΙΣΤΕΡΑ, H 
ΟΜΑΔΑ DRAW KAI 

ΔΕΞΙΑ, ΟΙ 
ΔΙΑΘΕΣΙΜΕΣ 

ΟΜΑΔΕΣ 
ΕΡΓΑΛΕΙΩΝ 
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3 

ΒΑΣΙΚΕΣ ΑΡΧΕΣ 
 

ΣΧΕΔΙΑΣΗΣ 
 

 
 
 
 
 
 
 
 
 

1. ΑΠΛΕΣ ΕΝΤΟΛΕΣ ΣΧΕΔΙΑΣΗΣ 

2. ΟΡΙΖΟΝΤΙΕΣ ΚΑΙ ΚΑΤΑΚΟΡΥΦΕΣ ΓΡΑΜΜΕΣ 

3. ΑΜΕΣΗ ΕΙΣΑΓΩΓΗ ΑΠΟΣΤΑΣΗΣ 

4. ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ ΣΗΜΕΙΑ ΕΛΞΗΣ 

5. ΠΡΟΣΘΕΤΑ ΕΡΓΑΛΕΙΑ ΠΡΟΣΔΙΟΡΙΣΜΟΥ ΣΗΜΕΙΩΝ 
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Στο τεχνικό σχέδιο πρέπει να παρουσιάζουμε αντικείμενα στα σωστά τους 

μεγέθη.  Το σχεδιαστικό πρόγραμμα μας προσφέρει πολλά εργαλεία για να 

σχεδιάζουμε με ακρίβεια, αποφεύγοντας λάθη που μπορεί να επηρεάσουν 

αρνητικά την κατασκευή του θέματος.   Η ακρίβεια της σχεδίασης επιπλέον 

εξασφαλίζει ότι το σχέδιο θα έχει και σωστές πληροφορίες και ωραία 

εμφάνιση.     

 
Στο κεφάλαιο αυτό θα εξετάσουμε μερικές απλές σχεδιαστικές εντολές και στη 

συνέχεια θα τις χρησιμοποιήσουμε για να μάθουμε να ελέγχουμε τα μεγέθη 

των αντικειμένων του σχεδίου. 

 
 
3.1  ΑΠΛΕΣ ΕΝΤΟΛΕΣ ΣΧΕΔΙΑΣΗΣ 

 
3.1.1    Line    

 Command Line:  Line ┘ ή L ┘ 
   Pull-down Menu:  Draw → Line  
 
 

Η εντολή LINE είναι μία από τις πιο απλές 

σχεδιαστικές εντολές του προγράμματος.  

Δημιουργεί συνεχόμενα, ανεξάρτητα, 

ευθύγραμμα τμήματα.  

 

 
2. 1 

3. 23  Η ΕΝΤΟΛΗ LINE 
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Τα τμήματα ενώνουν σημεία.  Τα σημεία τα προσδιορίζουμε με διάφορους 

τρόπους.  Ο πιό απλός τρόπος για να τα προσδιορίσουμε είναι να δείξουμε με 

το αριστερό πλήκτρο του ποντικιού πάνω στη σχεδιαστική επιφάνεια. 

Μπορούμε, όμως, να τα προσδιορίσουμε, πληκτρολογώντας συντεταγμένες 

στη γραμμή εντολών.   

 
Όταν χρησιμοποιούμε αυτή την εντολή, στη γραμμή εντολών εμφανίζονται οι 

παρακάτω προτροπές: 

Command: Line   ┘ 
Specify first point: Δείχνουμε το πρώτο σημείο. 

Specify next point or [Undo]: Επόμενο σημείο. 
Specify next point or [Undo]: Επόμενο σημείο. 

 
Η εντολή συνεχίζει να σχεδιάζει ευθύγραμμα τμήματα μέχρι να πιέσουμε το  

(ENTER) ή να διακόψουμε την εντολή με το Esc. 

 
Έχουμε διαθέσιμες και τις επιλογές:  
 
Undo Πληκτρολογούμε UΗ επιλογή αναιρεί το τελευταίο τμήμα 

που σχεδιάσαμε.  Χρησιμοποιούμε αυτή την επιλογή, όταν έχουμε 

κάνει κάποιο λάθος σε ένα τμήμα, αντί να ακυρώσουμε τη ροή της 

εντολής.  Αν την επαναλάβουμε, αναιρούνται διαδοχικά, κατ’ 

ανάστροφη φορά, όλα τα τμήματα της γραμμής. 

 

Πριν το U ┘   Μετά το U  ┘ 
 

3. 24 ΑΝΑΙΡΕΣΗ ΤΜΗΜΑΤΟΣ ΜΕ ΤΗΝ UNDO 

Close Πληκτρολογούμε C  Ενώνει το τελευταίο σημείο που δείξαμε 

με το πρώτο της σειράς και κλείνει το πολυγωνικό σχήμα που έχουμε 

δημιουργήσει.  
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Πριν το C  ┘   Μετά το C  ┘ 

3. 25 ΚΛΕΙΣΙΜΟ ΣΧΗΜΑΤΟΣ ΜΕ ΤΗΝ CLOSE 
 

 

3.1.2.   Circle 
 
Η εντολή CIRCLE δημιουργεί κύκλους. Η μορφή της εντολής που θα 

χρησιμοποιήσουμε εξαρτάται από τα δεδομένα του σχεδίου.  Μπορεί να 

γνωρίζουμε τη θέση του κέντρου και την ακτίνα του κύκλου ή να θέλουμε να 

ακουμπήσει σε τρεις γραμμές.  Οι διάφορες επιλογές παρουσιάζονται 

παρακάτω. 

 
3.1.2.1 Κέντρο και Ακτίνα.  

 Command Line:  Circle  ┘ ή C  ┘ 
 Pull-down Menu:  Draw → Circle  →Center, Radius 
  
Αυτή είναι η πιο συνηθισμένη επιλογή για να χαράξουμε ένα κύκλο με βάση το 

κέντρο και την ακτίνα.  Μπορούμε να πληκτρολογήσουμε την ακτίνα ή να την 

προσδιορίσουμε με ένα σημείο.   

κέντρο

ακτίνα

 
 
3.2  ΟΡΙΖΟΝΤΙΕΣ ΚΑΙ ΚΑΤΑΚΟΡΥΦΕΣ ΓΡΑΜΜΕΣ 
 
Ortho 
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 F8 
 Ortho ┘ επιλογές (ON ή OFF) 
    Status Bar: πιέζουμε με το αριστερό πλήκτρο στη λέξη Ortho. 
 
Η ρύθμιση ORTHO δεσμεύει το ποντίκι να σχεδιάζει μόνο οριζόντιες και 

κατακόρυφες γραμμές.  Διευκολύνει τη σχεδίαση όταν έχουμε ορθογώνια 

σχήματα.  Δεσμεύει επίσης την κίνηση των αντικειμένων, καθώς τα 

τροποποιούμε.  Αν το Ortho είναι ενεργοποιημένο, μπορούμε, για 

παράδειγμα, να μετακινούμε ένα έπιπλο αριστερά και δεξιά, πάνω και κάτω, 

αλλά όχι λοξά. 

3.3  ΑΜΕΣΗ ΕΙΣΑΓΩΓΗ ΑΠΟΣΤΑΣΗΣ 
 
Ο πιο άμεσος και εύκολος τρόπος να σχεδιάσουμε γραμμές με γνωστές 

αποστάσεις είναι η μέθοδος της Άμεσης Εισαγωγής Απόστασης (Direct 

Distance Entry).    Με το μηχανισμό αυτό, μπορούμε να σχεδιάσουμε 

γραμμές, αποφεύγοντας την υπερβολική χρήση του πληκτρολογίου που 

απαιτούν οι δύο παραπάνω μέθοδοι.  Η μέθοδος αυτή είναι ιδιαίτερα χρήσιμη 

όταν  σχεδιάζουμε οριζόντιες και κατακόρυφες γραμμές (με το Ortho ή το 

Polar Tracking ενεργοποιημένο).  Για να δημιουργήσουμε το παρακάτω 

περίγραμμα, δείχνουμε την κατεύθυνση του κάθε τμήματος με το ποντίκι 

(χωρίς να πιέσουμε το πλήκτρο του) και στη συνέχεια πληκτρολογούμε την 

απόσταση για το τμήμα 

4.20 3.50

4.0
5

2.5
0

2.80 4.90

2.0
5

4.5
0

 
3.26 ΣΧΕΔΙΑΣΜΟΣ ΠΕΡΙΓΡΑΜΜΑΤΟΣ ΜΕ ΑΜΕΣΗ ΕΙΣΑΓΩΓΗ ΑΠΟΣΤΑΣΗΣ 
 
Πρώτα προσέχουμε να δεσμεύσουμε το ποντίκι σε οριζόντια και κατακόρυφη 

κίνηση με την ρύθμιση ORTHO: 
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Command:   F8 <Ortho On> Πιέζοντας το F8 
δεσμεύουμε το ποντίκι για τη 
σχεδίαση οριζοντίων και 
κατακόρυφων γραμμών. 

 
Στη συνέχεια, σχεδιάζουμε το περίγραμμα: 
 

Command:    Line ┘ 
Specify first point: Προσδιορίζουμε τυχαίο σημείο στην 

οθόνη με το ποντίκι 
Specify next point or [Undo]:   Δείχνουμε δεξιά με το ποντίκι (χωρίς 

να πιέσουμε το πλήκτρο) και 
πληκτρολογούμε 4.2 ┘ 

Specify next point or [Undo]:   Δείχνουμε κάτω με το ποντίκι και 
πληκτρολογούμε 2.5 ┘  

Specify next point or [Undo]:   Δείχνουμε δεξιά με το ποντίκι και 
πληκτρολογούμε 3.5 ┘ 

Specify next point or [Undo]:   Δείχνουμε κάτω με το ποντίκι και 
πληκτρολογούμε 4.05 ┘ 

Specify next point or [Undo]:   Δείχνουμε αριστερά με το ποντίκι και 
πληκτρολογούμε 4.9  

Specify next point or [Undo]:   Δείχνουμε πάνω με το ποντίκι και 
πληκτρολογούμε 2.05 ┘ 

Specify next point or [Undo]:   Δείχνουμε αριστερά με το ποντίκι και 
πληκτρολογούμε 2.8  

Specify next point or [Undo]:   C┘   (κλείνει το σχήμα και 
ολοκληρώνεται η εντολή) 

 
3.4 ΧΑΡΑΚΤΗΡΙΣΤΙΚΑ ΣΗΜΕΙΑ ΕΛΞΗΣ 
 
Ο μηχανισμός OBJECT SNAP ή OSNAP (έλξη σε 

αντικείμενα) μας επιτρέπει να προσδιορίζουμε, 

όποτε χρειάζεται, σημεία σε χαρακτηριστικές 

θέσεις πάνω σε αντικείμενα του σχεδίου μας, 

έλκοντας αυτόματα το σταυρόνημα προς τα 

σημεία αυτά.   

Έτσι, μπορούμε  να προσδιορίσουμε σημεία, 

όπως το κέντρο ενός κύκλου ή την άκρη μιάς 

γραμμής.  Αφού πάρουμε το κατάλληλο εργαλείο 

(Osnap), πλησιάζουμε κοντά στο αντικείμενο και 

πιέζουμε το αριστερό πλήκτρο του ποντικιού.  

Αν έχουμε ποντίκι με τρία πλήκτρα, εμφανίζουμε 
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το μενού των Osnaps με το μεσαίο πλήκτρο.  Αν 

έχουμε μόνο δύο πλήκτρα, χρησιμοποιούμε το 

συνδυασμό SHIFT+ δεξί πλήκτρο.  

 

3. 27 ΤΟ ΜΕΝΟΥ ΤΩΝ 
OBJECT SNAPS 

 Το μεσαίο πλήκτρο ενεργοποιεί τα Osnaps μόνο αν η μεταβλητή 
MBUTTONPAN έχει τιμή 1
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3.4.1  Στιγμιαία Object Snaps. 
 
Τα στιγμιαία Object Snaps χρησιμοποιούνται κάθε φορά που το πρόγραμμα 

ζητεί ένα σημείο.  Τη στιγμή εκείνη εμφανίζουμε το μενού των Object Snaps 

για να κάνουμε την επιλογή μας.  Μόλις προσδιορίσουμε το σημείο, το 

πρόγραμμα ξεχνάει το τελευταίο Object Snap που χρησιμοποιήσαμε.  Αν 

αργότερα χρειαστούμε άλλο, πρέπει να το επιλέξουμε ξανά από το μενού.  Οι 

επόμενες σελίδες περιγράφουν όλα τα εργαλεία Object Snaps: 

 
 Endpoint Τέλος αντικειμένου - Προσδιορίζει ένα σημείο στην 

άκρη ενός αντικειμένου, όπως μιας γραμμής ή ενός 
τόξου.  

 
Για να σχεδιάσουμε μία διαγώνιο, σχεδιάζουμε μια 
γραμμή από τη μία γωνία του ορθογωνίου στην άλλη.  Η 
κάθε γωνία θεωρείται τέλος μίας γραμμής: 

 
Command:   Line ┘ 

Specify first point:   endpoint 
end of: Πλησιάζουμε το τέλος της μιας 

γραμμής και πιέζουμε το αριστερό 
πλήκτρο του ποντικιού 

Specify next point or [Undo]:  endpoint 
end of: Πλησιάζουμε το τέλος της άλλης 

γραμμής και πιέζουμε το αριστερό 
πλήκτρο του ποντικιού 

Specify next point or [Undo]:  ┘ 
 
Επαναλαμβάνουμε τη διαδικασία για την άλλη διαγώνιο. 
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 Midpoint  Μέσο αντικειμένου - Προσδιορίζει σημείο στο μέσο 

ενός αντικειμένου, όπως μίας γραμμής ή ενός τόξου. 

 
Ο ρόμβος αποτελείται από τέσσερις γραμμές που 
ενώνουν τα τέσσερα μεσαία σημεία του τετραγώνου: 

 
Command:    Line┘  

Specify first point:   midpoint 
mid of: Επιλογή πρώτης γραμμής κοντά στη 

μέση 
Specify next point or [Undo]:  midpoint 

mid of: Επιλογή επόμενης γραμμής στη μέση 
Specify next point or [Undo]:  midpoint 

mid of: Επιλογή επόμενης γραμμής στη μέση 
Specify next point or [Undo]:  midpoint 

mid of: Επιλογή επόμενης γραμμής στη μέση 
Specify next point or [Undo]:   C  ┘ 

 
 

 Intersection Τομή -  Προσδιορίζει σημείο στην  πραγματική τομή δύο 
αντικειμένων ή στην τομή της προέκτασής τους. 

 
Σχεδιάζουμε ένα κύκλο, του οποίου το κέντρο του θα 
είναι στην τομή των διαγωνιών.  Προσδιορίζουμε την 
ακτίνα, δείχνοντας στο μέσο της εξωτερικής γραμμής.  

 
Command:   Circle  ┘  

Specify center point for circle: intersection 
int of:  Επιλογή των δύο διαγωνίων κοντά 

στην τομή τους 
Specify radius or diameter: endpoint 

end of:        Επιλογή πλευράς ορθογωνίου κοντά 
στη μέση 

 38 



 
 Apparent 

Intersection 
Εμφανής Τομή (σε προβολή) - Η επιλογή αυτή είναι  
κυρίως για τρισδιάστατη σχεδίαση. 
 

 Extension Επέκταση - Προσδιορίζει σημείο στο ίχνος της 
προέκτασης μίας γραμμής. 

 
Στο παράδειγμα, σχεδιάζουμε ένα κύκλο, του οποίου το 
κέντρο του βρίσκεται πάνω στην προέκταση της 
γραμμής, σε απόσταση ενός μέτρου.  Η ακτίνα του 
κύκλου είναι επίσης 1 μέτρο. 

 
Command:  Circle  ┘ 

Specify center point for circle:   extension 
of: Πλησιάζουμε με το ποντίκι κοντά στην 

άκρη της γραμμής, χωρίς να 
πιέσουμε πλήκτρο στο ποντίκι.  
Καθώς κινούμε το ποντίκι πάνω στο 
ίχνος της γραμμής, πληκτρολογούμε 
1  ┘ 

Specify radius or diameter:  1  ┘ 
 

 Center Κέντρο - επιλέγει το κέντρο ενός καμπύλου 
αντικειμένου, όπως κύκλου, τόξου ή έλλειψης. 

 
Στο παράδειγμα σχεδιάζουμε ένα ρόμβο.  Οι κορυφές 
του ρόμβου περνούν από τα κέντρα των κύκλων. 

 
Command:    Line  ┘ 

Specify first point:   center 
cen of: Επιλογή ενός κύκλου 

Specify next point or [Undo]:  center 
cen of: Επιλογή επόμενου κύκλου 

Specify next point or [Undo]:  center 
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cen of: Επιλογή επόμενου κύκλου 
Specify next point or [Undo]:  center 

cen of: Επιλογή επόμενου κύκλου 
Specify next point or [Undo]:   C  ┘ 

  
 Quadrant  Σημείο Τεταρτοκυκλίου - Προσδιορίζει σημείο στην 

τομή των νοητών αξόνων με την περιφέρεια που 
περνούν από το κέντρο ενός κύκλου, τόξου ή έλλειψης.  

  
Ο ρόμβος αυτού του παραδείγματος περνάει από τα 
σημεία τεταρτοκυκλίου.   

 
 

Command:   Line  ┘ 
Specify first point:   quadrant 

qua of: Επιλογή του κύκλου στο αριστερό 
μέρος 

Specify next point or [Undo]:  quadrant 
qua of: Επιλογή του κύκλου στο πάνω μέρος 

Specify next point or [Undo]:  quadrant 
qua of: Επιλογή του κύκλου στη δεξιά 

πλευρά 
Specify next point or [Undo]:  quadrant 

qua of: Επιλογή του κύκλου στο κάτω μέρος 
Specify next point or [Undo]:   C  ┘ 

 
Command:    Line  

Specify first point:   tangent 
tan of: Επιλογή του πρώτου κύκλου στο 

πάνω μέρος 
Specify next point or [Undo]:  tangent 

tan of: Επιλογή του δεύτερου κύκλου στο 
πάνω μέρος 

Specify next point or [Undo]:   ┘ 
 
Επαναλαμβάνουμε τη διαδικασία για τη δεύτερη γραμμή.
 

 Perpendicul

ar 

Σημείο Καθέτου  - Αν έχουμε προηγουμένως επιλέξει 

ένα σημείο, μπορούμε να κινηθούμε κάθετα (σε 90 

μοίρες) προς κάποιο αντικείμενο (ή αντίθετα). 
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Οι γραμμές του σχήματος αρχίζουν στον κύκλο και 

έρχονται κάθετα προς τις λοξές πλευρές του εξαγώνου. 

   
Command:    Line  ┘ 

Specify first point:   quadrant 
qua of: Επιλογή του κύκλου στο πάνω μέρος 

Specify next point or [Undo]:  perpendicular 
per of: Επιλογή μίας πάνω πλευράς του 

εξαγώνου 
Specify next point or [Undo]:   ┘ 

 
Επαναλαμβάνουμε την διαδικασία για τις υπόλοιπες γραμμές. 

 Parallel Παράλληλο Ίχνος - Προσδιορίζει ένα παράλληλο ίχνος, 
κάνοντας το ποντίκι να κινείται παράλληλα με μία 
υπάρχουσα γραμμή. 

 
Στο παράδειγμα σχεδιάζουμε μία γραμμή παράλληλη με 
την πρώτη.  Η νέα γραμμή αρχίζει το κέντρο του κύκλου 
και έχει μήκος 2 μέτρα. 

 
Command:    Line  ┘ 

Specify first point:  center 
cen of: Επιλογή του κύκλου 

Specify next point or [Undo]:  parallel 
par to: Πλησιάζουμε με το ποντίκι κοντά στη 

γραμμή χωρίς να πιέσουμε το 
πλήκτρο, μέχρι να εμφανιστεί ένας 
σταυρός. Στη συνέχεια κινούμε το 
ποντίκι πάνω στο ίχνος, παράλληλα 
με την υπάρχουσα γραμμή. 

Specify next point or [Undo]:  2 ┘  
 

 Node  Κόμβος - Προσδιορίζει σημεία πάνω σε ανεξάρτητα 

 41 



σχεδιαστικά αντικείμενα που ονομάζονται Points 
(Σημεία). 

 
Στο παράδειγμα σχεδιάζουμε μία γραμμή που περνάει 
από τα Σημεία του σχεδίου. 

 
Command:    Line  

Specify first point:   node 
nod of: Επιλογή πρώτου Σημείου. 

Specify next point or [Undo]:  node 
nod of: Επιλογή επόμενου Σημείου. 

Specify next point or [Undo]:  node 
nod of: Επιλογή επόμενου Σημείου. 

Specify next point or [Undo]:  node 
nod of: Επιλογή επόμενου Σημείου. 

Specify next point or [Undo]:  node 
nod of: Επιλογή επόμενου Σημείου. 

Specify next point or [Undo]:  node 
nod of: Επιλογή επόμενου Σημείου. 

Specify next point or [Undo]:   C  
 

 Insert Σημείο Εισαγωγής (Βάσης) - Όλα τα σύμβολα και 
κείμενα έχουν ένα σημείο βάσης, με το οποίο γίνεται  η 
τοποθέτησή τους στο σχέδιο.  Αυτό το σημείο 
προσδιορίζεται με τη βοήθεια της επιλογής Insert.  
 

 
 

Στο παράδειγμα, τοποθετούμε ένα κύκλο (το τραπέζι) με 
τέτοιο τρόπο που να περνάει από όλα τα σημεία βάσης 
των συμβόλων που παριστάνουν καρέκλες. 

 
Pull-down Menu:  Draw  Circle  3 Points 
 

3p Specify first point on circle:  insert 
ins of:   Επιλογή της πρώτης καρέκλας 
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Specify second point on circle:  insert 
ins of:   Επιλογή επόμενης καρέκλας 

Specify third point on circle:  insert 
ins of:   Επιλογή επόμενης καρέκλας 

 
 Nearest Πλησιέστερο - Προσδιορίζει ένα τυχαίο σημείο, το οποίο 

όμως βρίσκεται πάνω στο αντικείμενο. 

 
Στο παράδειγμα σχεδιάζουμε μία γραμμή από ένα τυχαίο 
σημείο μίας γραμμής προς ένα τυχαίο σημείο της άλλης 
γραμμής. 
 

 
Command:    Line  ┘ 

Specify first point:   nearest 
nea of: Επιλογή της πρώτης γραμμής 

Specify next point or [Undo]:  nearest 
nea of: Επιλογή της δεύτερης γραμμής 

Specify next point or [Undo]:    ┘ 

 None Απελευθερώνει προσωρινά το χρήση από τη μόνιμη 
λειτουργία των Osnaps. (βλ. επόμενο τμήμα). 
 

 From Σημείο Αναφοράς - Προσδιορίζει σημείο εξαρτώμενο 
από άλλο γνωστό σημείο.  Πληκτρολογούμε την 
απόσταση από αυτό το σημείο αναφοράς με σχετικές 
καρτεσιανές ή πολικές συντεταγμένες. 

 
Αν θέλουμε να σχεδιάσουμε το εσωτερικό ορθογώνιο και 
το πρώτο του σημείο να είναι μισό μέτρο δεξιά και μισό 
μέτρο κάτω από την πάνω αριστερή γωνία του 
σχήματος, ακολουθούμε την παρακάτω διαδικασία: 
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Command:    Line  
Specify first point: From┘ 

from base point:  endpoint 
<offset>: @.5,-.5 ┘ 

Specify next point or [Undo]:   @1<0  ┘ 
 
Οι τέσσερις πλευρές του ορθογωνίου σχεδιάζονται με το συνήθη τρόπο. 
 
 
3.4.2  Μόνιμα Object Snaps 
 
Τα Object Snaps που εξετάσαμε μέχρι τώρα χρησιμοποιούνται  για να 

προσδιορίσουμε με ακρίβεια ένα μόνο σημείο κάθε φορά.  Αν χρειαστεί, όμως 

να σχεδιάσουμε μία γραμμή που να περνάει μέσα από τα κέντρα πολλών 

κύκλων,  πρέπει να επαναλάβουμε πολλές φορές την επιλογή Center.  Για να 

αποφύγουμε αυτή την επαναληπτική κίνηση, μπορούμε να ενεργοποιήσουμε 

μερικά Object Snaps σε  μόνιμη, τρέχουσα λειτουργία (Running Object 

Snaps).  

 
1. 28 ΣΧΕΔΙΑΣΗ ΓΡΑΜΜΗΣ ΜΕΣΑ ΑΠΟ ΚΕΝΤΡΑ ΚΥΚΛΩΝ 

 
Οι παρακάτω μέθοδοι εμφανίζουν τον πίνακα των Object Snaps: 
 
 Command Line:  Osnap  ┘ 
   Status Bar: πιέζουμε το δεξιό πλήκτρο του ποντικιού  και στη συνέχεια  

την επιλογή Settings  
 Cursor Menu: πιέζουμε το μεσαίο πλήκτρο στο  ποντίκι και στη 

συνέχεια την επιλογή Osnap Settings  
 
Στον πίνακα της εντολής επιλέγουμε όλα τα Object Snaps που θέλουμε να  

έχουμε σε μόνιμη λειτουργία.  

 
3. 29 Ο ΠΙΝΑΚΑΣ ΤΩΝ ΜΟΝΙΜΩΝ OBJECT SNAP 

 
Object Snap On (F3) Ενεργοποιεί / Απενεργοποιεί τη λειτουργία 

των Osnaps (χωρίς να ξεχνάει ποια 
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έχουμε διαλέξει). 
 

Object Snap Tracking On (F11) Ενεργοποιεί / Απενεργοποιεί τη λειτουργία 
της εξιχνίασης με Osnaps (βλ. επόμενο 
τμήμα). 
 

Select All Ενεργοποιεί όλα τα Osnaps. 
 

Clear All Απενεργοποιεί όλα τα Osnaps. 
 
3.5  ΠΡΟΣΘΕΤΑ ΕΡΓΑΛΕΙΑ ΓΙΑ ΝΑ ΠΡΟΣΔΙΟΡΙΣΟΥΜΕ ΣΗΜΕΙΑ  
 
3.5.1  Object Snap Tracking 
 
Με το μηχανισμό του Osnap Tracking, μπορούμε να εκμεταλλευτούμε τα 

Object Snaps για να προσδιορίζουμε άλλα σημεία, που είναι σε κατακόρυφη, 

οριζόντια ή λοξή περασιά με χαρακτηριστικά σημεία πάνω σε αντικείμενα.   

Ενεργοποιούμε το μηχανισμό σε δύο βήματα: 

1.  Ενεργοποιούμε τουλάχιστον ένα Object Snap 
 
2.  Ενεργοποιούμε το Osnap Tracking με ένα από τους παρακάτω τρόπους: 
 
 F11  ┘      ή     Status Bar: Otrack  
 
Ο μηχανισμός αρχίζει να λειτουργεί και μπορούμε να προχωρήσουμε στα 

παρακάτω βήματα: 

1.  Ξεκινούμε μία σχεδιαστική εντολή (ή μία εντολή τροποποίησης). 
  
2.  Στοχεύουμε με το ποντίκι πάνω σε ένα σημείο, χωρίς να πιέσουμε το 

πλήκτρο στο ποντίκι.  Τότε εμφανίζεται ένας σταυρός στο σημείο αυτό.  
  
3.  Στοχεύουμε σε όσα πρόσθετα σημεία θέλουμε.  
 

 Αν θέλουμε να αναιρέσουμε την επιλογή ενός σημείου, στοχεύουμε 
πάλι στο ίδιο σημείο. 

  
  
4.  Εμφανίζονται στην οθόνη διακεκομμένα ίχνη (κατακόρυφα, οριζόντια, ή 

κεκλιμένα) για κάθε σημείο που έχουμε επιλέξει.  Καθοδηγούμε το ποντίκι 
σε σταθερή πορεία πάνω σε ένα ίχνος.   

  
5.  Πληκτρολογούμε το μήκος της μετακίνησης και Αν θέλουμε να 

προσδιορίσουμε ένα σημείο που βρίσκεται σε κατακόρυφη και οριζόντια 
περασιά δύο σημείων μαζί, κινούμε το ποντίκι, ώστε να στοχεύει στην τομή 
και των δύο ιχνών ταυτόχρονα και πιέζουμε το αριστερό πλήκτρο στο 
ποντίκι.  
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 Tangent Σημείο Εφαπτομένης - Προσδιορίζει σημείο 
εφαπτομένης σε κύκλο ή τόξο. 

 
Οι γραμμές του σχεδίου εφάπτονται στους δύο κύκλους. 
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ΑΠΛΕΣ ΡΥΘΜΙΣΕΙΣ 
 
 
 

 

 

 

 

 

1. ΜΟΝΑΔΕΣ ΜΕΤΡΗΣΗΣ ΣΧΕΔΙΩΝ 
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4.1  ΜΟΝΑΔΕΣ ΜΕΤΡΗΣΗΣ ΤΟΥ ΣΧΕΔΙΟΥ 
 
 
4.1.1  Units 
 
 Command Line:  Units┘   
 Pull-down Menu:  Format → Units  
 
 
Με την εντολή UNITS ρυθμίζουμε τη μονάδα μέτρησης μηκών και γωνιών.  

Μπορούμε στον παρακάτω πίνακα να αποφασίσουμε αν θέλουμε να 

σχεδιάσουμε σε μέτρα ή σε χιλιοστά.  Επιλέγουμε, ακόμη, τη μορφή, με την 

οποία θα εμφανίζονται οι αριθμοί στην οθόνη, καθώς και το βαθμό ακριβείας 

τους.  ‘Έχουμε τη δυνατότητα να εμφανίσουμε μέχρι οκτώ δεκαδικά ψηφία. 

 

  Οι ρυθμίσεις της εντολής αυτής μοιάζουν πολύ με τις επιλογές 
στον πίνακα Startup της εκκίνησης νέου σχεδίου. 

 
 

 
4. 1  Ο ΠΙΝΑΚΑΣ ΤΗΣ ΕΝΤΟΛΗΣ DRAWING UNITS 

 
Η εντολή αυτή δεν επηρεάζει την εμφάνιση των διαστάσεων.  Για τις 

διαστάσεις έχουμε ξεχωριστό έλεγχο (στην εντολή Dimension Style).  Η 

εντολή Units επηρεάζει τον τρόπο, με τον οποίο πληκτρολογούμε τα μεγέθη 

για τα αντικείμενα, καθώς και τη μορφή των πληροφοριών που θα μας 

παρουσιάζει το πρόγραμμα.  
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4.1.1.1  Length (Μήκη) 
 
Στην περιοχή αυτή υπάρχουν δύο ενδείξεις: 
 
Type    Ρυθμίζει τη μορφή της μονάδας μήκους. 
 
 
Architectural  Πόδια και ίντσες, σε κλασματική μορφή. 
Decimal Δεκαδική. 
Engineering Πόδια και ίντσες, σε δεκαδική μορφή. 
Fractional Κλασματική. 
Scientific Εκθετική. 
 
Precision  Ρυθμίζει την ακρίβεια της μέτρησης (αριθμός 

δεκαδικών ψηφίων). 
 

 
4. 2  Ο ΠΙΝΑΚΑΣ PRECISION 

4.1.1.2  Angle (Γωνία) 
 
Στην περιοχή Angle υπάρχουν επίσης δύο ενδείξεις:   
 
Type Ρυθμίζει τη μορφή της γωνίας. 
 
 
Decimal Degrees  Μοίρες σε δεκαδική μορφή. 
Deg/Min/Sec Μοίρες σε πρώτα / δεύτερα / λεπτά. 
Grads Βαθμοί. 
Radians Ακτίνια. 
Surveyor’s Units Τοπογραφικές μονάδες. 
 
Precision Ρυθμίζει την ακρίβεια της μέτρησης (αριθμό 

δεκαδικών ψηφίων). 
 
4.3.2  Grid 
 
Αν πιέσουμε το F7 στο πληκτρολόγιο, εμφανίζεται ένα πλέγμα με κουκίδες σε 

ίσα διαστήματα. Είναι ένας βοηθητικός κάναβος, ο οποίος μας διευκολύνει 
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στον υπολογισμό του μεγέθους των αντικειμένων με το μάτι. Αυτό το πλέγμα 

ονομάζεται GRID και δεν εκτυπώνεται. 

 
 Status Bar: Πιέζουμε με το δεξιό πλήκτρο στο ποντίκι τη λέξη Grid και 

στη συνέχεια επιλέγουμε την εντολή Settings. 
 Pull-down Menu:  Tools  → Drafting Settings 
 Dsettings┘  
 
Grid On/OFF (F7)   Εμφανίζει ή εξαφανίζει το πλέγμα. 
 
Grid Χ Spacing   Ρυθμίζει τη διάσταση του πλέγματος παράλληλα με τον 

άξονα Χ. 
 
Grid Υ Spacing  Ρυθμίζει τη διάσταση του πλέγματος παράλληλα με τον 

άξονα Υ. 
 
Μπορούμε να ενεργοποιούμε ή να απενεργοποιούμε το Grid όποτε θέλουμε 

την ώρα της σχεδίασης, με τους παρακάτω τρόπους: 

 
     F7   
 Status Bar: Πιέζουμε το αριστερό πλήκτρο του ποντικιού στο πλαίσιο 

Grid. 
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ΑΠΕΙΚΟΝΙΣΗ ΤΟΥ ΣΧΕΔΙΟΥ 

 

 

 

 

 

 

1. ΑΛΛΑΓΗ ΕΙΚΟΝΑΣ ΤΟΥ ΣΧΕΔΙΟΥ 
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Όταν έχουμε μεγάλο σχέδιο και το βλέπουμε ολόκληρο στην οθόνη, δεν 

μπορούμε να δούμε καθαρά όλα τα στοιχεία που το αποτελούν.  Το 

σχεδιαστικό πρόγραμμα διαθέτει πολλά εργαλεία, για να εστιάζουμε στο 

σημείο που θέλουμε να επεξεργαστούμε. 

Όταν θέλουμε να δούμε μία λεπτομέρεια, πρέπει να πλησιάσουμε στη 

συγκεκριμένη περιοχή του σχεδίου.  Όταν θέλουμε να δούμε τη συνολική 

διάταξη του φύλλου, απομακρυνόμαστε από αυτό.   Αυτό γίνεται με τη χρήση 

των παρακάτω εντολών. 

 

5.1.  ΑΛΛΑΓΗ ΤΗΣ ΕΙΚΟΝΑΣ ΤΟΥ ΣΧΕΔΙΟΥ 

5.1.1  Zoom 
 
H εντολή ZOOM μας δίνει τη δυνατότητα να μεγαλώσουμε ή να μικρύνουμε  

την εικόνα του σχεδίου πάνω στην οθόνη, πλησιάζοντας ή απομακρυνόμενοι 

από αυτό.  Διαθέτει πολλές επιλογές και έτσι μπορούμε να χρησιμοποιήσουμε 

τον τρόπο που μας ταιριάζει καλύτερα. 

 
 Command Line:  Zoom ┘ 
 Pull-down Menu:  View  → Zoom  
 
Οι επιλογές της εντολής είναι οι εξής: 
 

  
Window 

Στο 
Παράθυρο. 

Γεμίζει την οθόνη με την περιοχή του 

παραθύρου που θα προσδιορίσουμε.  

 

   
 πριν το Zoom Window   μετά το Zoom Window 

5. 1   Η ΧΡΗΣΗ ΤΟΥ ΖΟΟΜ WINDOW 
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5.1.2         Pan 
 
 Command Line:  Pan  ┘ 
 Pull-down Menu:  View  → Pan → Realtime 
 
Η εντολή PAN μας δίνει τη δυνατότητα να μετακινούμε την εικόνα του σχεδίου 

πάνω στην οθόνη. 

 
Όταν αρχίζουμε την εντολή αυτή, το σταυρόνημα αλλάζει σε εικόνα χεριού.  

Πιέζοντας σταθερά το αριστερό πλήκτρο στο ποντίκι καθώς το κινούμε, 

αλλάζει η θέση της εικόνας.   Όταν ελευθερώσουμε το πλήκτρο στο ποντίκι, η 

κίνηση σταματάει. Η εντολή ολοκληρώνεται όταν πιέσουμε το   ή με το 

δεξιό πλήκτρο στο ποντίκι και μετά επιλέξουμε τη λέξη EXIT). 
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ΕΠΙΛΟΓΗ ΑΝΤΙΚΕΙΜΕΝΩΝ 

 

 

 

 

 
1. ΔΙΑΓΡΑΦΗ ΑΝΤΙΚΕΙΜΕΝΩΝ 
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6.1  ΔΙΑΓΡΑΦΗ ΑΝΤΙΚΕΙΜΕΝΩΝ 
 
 
6.1.1    Erase 
 
Με την εντολή ERASE μπορούμε να διαγράψουμε ένα ή πολλά αντικείμενα 

από το σχέδιό μας.   

 Command Line:  Erase ┘ ή E ┘ 
 Pull-down Menu:  Modify → Erase 
 
Πρώτα η εντολή μας προτρέπει να επιλέξουμε τα αντικείμενα  που θέλουμε να 

διαγράψουμε.  Η προτροπή Select Objects: για την επιλογή των 

αντικειμένων  επαναλαμβάνεται για να επιλέξουμε πολλά αντικείμενα στην 

οθόνη.  Τελειώνουμε τις επιλογές πιέζοντας   και αυτά διαγράφονται 

αμέσως. 

 
6. 1  ΣΒΗΣΙΜΟ ΕΠΙΠΛΩΝ 

Στο παράδειγμα, σβήνουμε μερικά έπιπλα από την κάτοψη. 
 

Command: Erase ┘ 
Select objects: Επιλέγουμε τον καναπέ. 
Select objects: Επιλέγουμε το τραπέζι. 
Select objects: Επιλέγουμε μία πολυθρόνα. 
Select objects: Επιλέγουμε την άλλη πολυθρόνα. 
Select objects: ┘(για να σταματήσουμε να 

επιλέγουμε αντικείμενα και να 
ολοκληρωθεί η εντολή). 
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ΕΝΤΟΛΕΣ 
ΤΡΟΠΟΠΟΙΗΣΗΣ 

 
 
 
 
                   
 
 
 
 
 
 
 

1.  ΑΠΛΕΣ ΕΝΤΟΛΕΣ ΤΡΟΠΟΠΟΙΗΣΗΣ 
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7.1  ΑΠΛΕΣ ΕΝΤΟΛΕΣ ΤΡΟΠΟΠΟΙΗΣΗΣ 

7.1.1    Move 
 
Με την εντολή MOVE μπορούμε να μετακινήσουμε ένα ή πολλά αντικείμενα 

από ένα σημείο του σχεδίου μας σε άλλο, χωρίς να αλλάξουμε τον 

προσανατολισμό ή το μέγεθός τους.    

 
 Command Line:  Move ┘  ή M ┘ 
         Pull-down Menu:  Modify  → Move  
 
 
‘Όταν αρχίζουμε την εντολή Move, εμφανίζονται στη γραμμή εντολής, τα 

παρακάτω μηνύματα: 

 
Command: Move┘  

Select objects: Δείχνουμε τι θέλουμε να 
μετακινήσουμε. 

Select objects: 
 

 (για να σταματήσουμε να 
επιλέγουμε αντικείμενα). 

Specify base point or 
displacement: 

 

Πρώτο σημείο ή πληκτρολογούμε τη 
μετατόπιση.  

Specify second point of 
displacement or <use first point as 

displacement>: 

Δεύτερο σημείο ή μόνο  ┘ 
 

 
 
7.1.2    Copy 
 
Με την εντολή COPY μπορούμε να αντιγράψουμε ένα ή πολλά αντικείμενα 

από ένα σημείο του σχεδίου μας σε άλλο, χωρίς να αλλάξουμε τον 

προσανατολισμό ή το μέγεθός τους.  

 Command Line:  Copy  ┘ή Co┘  ή Cp ┘ 
 Pull-down Menu:  Modify  → Copy  
 
Πρώτα, η εντολή θα ζητήσει να επιλέξουμε το αντικείμενο ή τα αντικείμενα 

που θέλουμε να μετακινήσουμε.  Όταν δεν θέλουμε να δείξουμε άλλα 

αντικείμενα, πιέζουμε το .   

Οι τρόποι, με τους οποίους καθορίζουμε τη μετατόπιση, είναι οι ίδιοι με 

αυτούς της εντολής Move. 
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Μπορούμε, επίσης, να κάνουμε πολλαπλή αντιγραφή με την επιλογή Multiple. 

Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα: 

Command: Copy ┘ 
Select objects: Δείχνουμε τι θέλουμε να 

αντιγράψουμε. 
Select objects: 

 
┘ (για να σταματήσουμε να 
επιλέγουμε αντικείμενα). 

Specify base point or 
displacement: or [Multiple]: 

Πρώτο σημείο ή πληκτρολογούμε την 
μετατόπιση ή επιλέγουμε Multiple.  

Specify second point of 
displacement or <use first point as 

displacement>: 

Δεύτερο σημείο ή ┘ .  Αν έχουμε 
επιλέξει την Multiple, μόνο δεύτερο 
σημείο. 

 
 
7.1.3     Rotate 

Με την εντολή ROTATE μπορούμε να περιστρέψουμε ένα ή πολλά 

αντικείμενα γύρω από ένα σημείο.   Μπορούμε να καθορίσουμε τη γωνία 

περιστροφής είτε πληκτρολογώντας μία γωνία είτε δείχνοντάς την με το 

ποντίκι.  Μπορούμε επίσης να συσχετίσουμε την περιστροφή με κάποια 

γνωστή κατεύθυνση. 

 
 Command Line:  Rotate┘  ή Ro  ┘ 
 Pull-down Menu:  Modify  → Rotate 
 
Στη γραμμή εντολών, εμφανίζονται τα εξής μηνύματα: 
 

Command: Rotate ┘ 
Select objects: 

 
Επιλέγουμε τα αντικείμενα που 
θέλουμε να περιστρέψουμε. 

Select objects: 
 

┘ (για να σταματήσουμε να 
επιλέγουμε αντικείμενα). 

Specify base point: 
 

Ορίζουμε το σημείο του κέντρου της 
περιστροφής. 

Specify rotation angle or 
[Reference]: 

Καθορίζουμε τη γωνία. 

 
 
7.1.5    Offset 
 
Η εντολή OFFSET δημιουργεί ένα παράλληλο αντίγραφο ενός αντικειμένου.  

Μπορούμε να καθορίσουμε την απόσταση, την οποία που θα έχουν μεταξύ 

τους τα αντικείμενα, ή να ορίσουμε ότι η προέκταση του νέου αντικειμένου θα 

διέρχεται μέσα από ένα γνωστό σημείο. 
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Η εντολή OFFSET είναι πιο γρήγορη από την COPY για την αντιγραφή 

πολλών παράλληλων γραμμών. 

 
 Command Line:  Offset┘ ή O ┘ 
 Pull-down Menu:  Modify → Offset 
 
Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα: 

 
Command:  Offset  ┘ 

Specify offset distance or 
[Through]: 

 

Ορίζουμε την απόσταση μεταξύ των 
αντικειμένων. 

Select object to offset or <exit>: 
 

Επιλέγουμε το αντικείμενο που θα 
αντιγράψουμε. 

Specify point on side to offset: 
 

Με το ποντίκι προσδιορίζουμε την 
πλευρά, στην οποία θα αντιγραφεί το 
αντικείμενο. 

Select object to offset or <exit>: 
 

Επιλέγουμε νέο αντικείμενο ή 
πιέζουμε το ┘ για να 
ολοκληρώσουμε την εντολή. 

 
7.1.6    Mirror 
 
Η εντολή MIRROR δημιουργεί συμμετρικά αντίγραφα αντικειμένων σε σχέση 

με μία αξονική γραμμή. 

 
 Command Line:  Mirror ┘ ή Mi  ┘ 
 Pull-down Menu:  Modify → Mirror 
 
Στη γραμμή εντολών, εμφανίζονται τα εξής μηνύματα: 
 

Command:  Mirror ┘ 
Select objects:  

 
Επιλέγουμε τα αντικείμενα που 
θέλουμε να αντιγράψουμε.  

Select objects: 
 

Πιέζουμε ┘ για να σταματήσουμε να 
επιλέγουμε αντικείμενα. 

Specify first point of mirror line:  
 

Προσδιορίζουμε το πρώτο σημείο 
πάνω στο νοητό ή υπαρκτό άξονα 
συμμετρίας. 

Specify second point of mirror line: 
 

Επιλέγουμε το δεύτερο σημείο πάνω 
στον άξονα συμμετρίας. 

Delete source objects? [Yes/No] 
<N>: 

 

Δηλώνουμε αν θέλουμε να 
διαγράψουμε τα πρωτότυπα 
αντικείμενα. 

 
 

 59 



 
 
7.1.8     Trim 
 
Η εντολή TRIM κόβει αντικείμενα μέχρι ή πέρα από κάποιο υπάρχον όριο.  Αν 

διαλέξουμε μόνο ένα όριο, θα κοπεί το αντικείμενο από την άκρη του έως το 

όριο.  Αν διαλέξουμε πολλά όρια, θα κοπεί το αντικείμενο μεταξύ των ορίων.   

 
Η εντολή ζητεί να επιλέξουμε δύο ομάδες αντικειμένων.  Πρώτα επιλέγουμε τα 

όρια κοπής.  Μπορούμε να χρησιμοποιήσουμε όλα τα γνωστά εργαλεία για τη 

διαδικασία Select Objects.   Όταν έχουμε τελειώσει με τον καθορισμό των 

ορίων, πιέζουμε το ┘   Στη συνέχεια, το πρόγραμμα θα μας ζητήσει να 

επιλέξουμε τα αντικείμενα που θα κοπούν πάνω στην πλευρά που θα 

διαγραφεί.  Μπορούμε να τα δείχνουμε επιλεκτικά ή να χρησιμοποιήσουμε το 

εργαλείο Fence. 

 Η εντολή Trim δεν μπορεί να διαγράψει αντικείμενα εντελώς.  Κόβει 
τμήματα αντικειμένων, αλλά προϋποθέτει ότι μετά την κοπή θα 
παραμείνει στο σχέδιο τουλάχιστον ένα τμήμα από το αρχικό 
αντικείμενο.  Αν θέλουμε να διαγράψουμε ένα αντικείμενο, 
χρησιμοποιούμε την εντολή Erase.   

 
 
 Command Line:  Trim ┘ ή Tr ┘ 
 Pull-down Menu:  Modify → Trim 
 
Στη γραμμή εντολών, εμφανίζονται τα εξής μηνύματα: 
 

Command:  Trim ┘ 
Current settings: Projection=UCS 

Edge=None 
Πληροφορίες για το επίπεδο 
προβολής και για τη νοητή επέκταση 
των ορίων. 

Select cutting edges ... Μήνυμα για να επιλέξουμε τα όρια 
κοπής. 

Select objects:  
 
 
 
 

Επιλέγουμε τα όρια κοπής.  Αν 
πιέσουμε το ┘ το πρόγραμμα θα 
θεωρήσει ότι όλα τα αντικείμενα που 
φαίνονται στην οθόνη είναι όρια 
κοπής.  Αυτή η επιλογή 
αντενδείκνυται αν το σχέδιο είναι 
πολύπλοκο. 

Select objects: 
 

Πιέζουμε┘  για να σταματήσουμε να 
επιλέγουμε όρια. 

Select object to trim or 
[Project/Edge/Undo]: 

Επιλέγουμε τα αντικείμενα που θα 
κοπούν πάνω στην πλευρά που 
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θέλουμε να διαγραφεί.  Επιλέγουμε P  
┘ για την επιλογή Project ή E┘ για 
την επιλογή Edge. 

Select object to trim or 
[Project/Edge/Undo]: 

 

Πιέζουμε ┘ για να σταματήσουμε να 
επιλέγουμε αντικείμενα και για να 
ολοκληρώσουμε την εντολή. 

 
 
 
 
 
7.1.9    Extend 
 
Η εντολή EXTEND επεκτείνει αντικείμενα μέχρι κάποια όρια.  Η λειτουργία 

μοιάζει με αυτή της εντολής TRIM αλλά το αποτέλεσμα είναι το αντίστροφο. 

Η εντολή ζητεί να επιλέξουμε δύο ομάδες αντικειμένων.   

Πρώτα επιλέγουμε τα όρια επέκτασης.  Μπορούμε να χρησιμοποιήσουμε όλα 

τα γνωστά εργαλεία για τη διαδικασία Select Objects.   Όταν έχουμε τελειώσει 

με τον καθορισμό των ορίων, πιέζουμε το ┘ .Στη συνέχεια, το 

πρόγραμμα θα μας ζητήσει να επιλέξουμε τα αντικείμενα που θα επεκταθούν 

από την πλευρά, προς την οποία θα επεκταθούν.  Μπορούμε να τα δείξουμε 

επιλεκτικά ή να χρησιμοποιήσουμε το εργαλείο Fence. 

 
 Command Line:  Extend┘  ή Ex┘   
  Pull-down Menu:  Modify  →Extend 
 
Στη γραμμή εντολών, εμφανίζονται τα εξής μηνύματα: 
 

Command:  Extend ┘ 
Current settings: Projection=UCS 

Edge=None 
Πληροφορίες για το επίπεδο 
προβολής και για τη νοητή επέκταση 
των ορίων. 

Select boundary edges ... 
 

Μήνυμα για να επιλέξουμε τα όρια 
επέκτασης. 

Select objects:  
 
 
 

Επιλέγουμε τα όρια επέκτασης.  Αν 
πιέσουμε το ┘ το πρόγραμμα θα 
θεωρήσει ότι όλα τα αντικείμενα που 
φαίνονται στην οθόνη είναι όρια 
επέκτασης.   

Select objects: 
 

Πιέζουμε ┘  για να σταματήσουμε 
να επιλέγουμε όρια. 

Select object to extend or 
[Project/Edge/Undo]: 

 

Επιλέγουμε τα αντικείμενα που θα 
επεκταθούν προς τη πλευρά του 
επιθυμητού ορίου.  Επιλέγουμε P      
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 ┘   για την επιλογή Project ή E  ┘για 
την επιλογή Edge. 

Select object to extend or 
[Project/Edge/Undo]: 

 

Πιέζουμε  ┘ για να σταματήσουμε 
να επιλέγουμε αντικείμενα και για να 
ολοκληρώσουμε την εντολή. 

 
7.1.10    Fillet 
 
Η εντολή FILLET καμπυλώνει την τομή δύο γραμμών, δηλαδή τις ενώνει με 

τόξο.  Μπορεί όμως και να ενώσει καμπύλα αντικείμενα, όπως κύκλους και 

ελλείψεις.  

 
 Command Line:  Fillet  ┘ ή F  ┘ 
 Pull-down Menu:  Modify → Fillet 
 
Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα: 
 

Command:  Fillet ┘ 
Current settings: Mode = TRIM, 

Radius = 0.60 
Πληροφορίες για τις τρέχουσες 
ρυθμίσεις της εντολής. 

Select first object or 
[Polyline/Radius/Trim]: 

Δείχνουμε το πρώτο αντικείμενο ή 
επιλέγουμε μία από τις τρεις 
ρυθμίσεις. 

Select second object: Δείχνουμε το δεύτερο αντικείμενο. 
 
 
7.1.11    Chamfer 
 
Η εντολή CHAMFER ενώνει δύο γραμμές με ευθύγραμμο τμήμα, 

δημιουργώντας μία απότμηση.  Είναι παρόμοια με την εντολή FILLET.  

Ορίζουμε πρώτα τις αποστάσεις που θα έχει το ευθύγραμμο τμήμα από την 

τομή των δύο γραμμών και στη συνέχεια επαναλαμβάνουμε την εντολή για να 

επιλέξουμε τις δύο γραμμές.  

Η εντολή Chamfer έχει τη δυνατότητα να προσαρμόσει τις γραμμές μέχρι να 

συναντήσουν το ευθύγραμμο τμήμα.  

Πολύ συχνά χρησιμοποιούμε την CHAMFER, δίνοντας μηδενικές αποστάσεις 

για να συναντηθούν οι γραμμές στο σημείο τομής τους. 

 
 Command Line:  Chamfer┘  ή Cha  ┘  
 Pull-down Menu:  Modify  → Chamfer 
 
Στη γραμμή εντολών εμφανίζονται τα παρακάτω μηνύματα: 
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Command:  Fillet  ┘ 
(TRIM mode)Current chamfer 

Dist1=1.00,  Dist2=1.00 
Πληροφορίες για τις τρέχουσες 
ρυθμίσεις τις εντολής. 

Select first line or 
[Polyline/Distance/ 

Angle/Trim/Method]: 

Επιλέγουμε την πρώτη γραμμή ή 
επιλέγουμε μία από τις τέσσερις 
ρυθμίσεις. 

Select second line: Επιλέγουμε τη δεύτερη γραμμή. 
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ΙΔΙΟΤΗΤΕΣ 

 
 
 
 
 
 
 
 

1. ΙΔΙΟΤΗΤΕΣ ΑΝΤΙΚΕΙΜΕΝΩΝ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 64 



8.1  ΙΔΙΟΤΗΤΕΣ ΑΝΤΙΚΕΙΜΕΝΩΝ 
 
8.1.1      Layers 
 
 Command Line:  Layer┘  ή La ┘ 
   Pull-down Menu:  Format → Layer 
 
Μπορούμε να τοποθετήσουμε τα αντικείμενα του σχεδίου μας σε ένα ή 

περισσότερα διαφανή φύλλα. Τα φύλλα αυτά έχουν πάντα σταθερή θέση 

μεταξύ τους.  Μπορούμε να οργανώσουμε τα αντικείμενα του σχεδίου σε 

ομάδες και να τοποθετήσουμε κάθε ομάδα σε ένα ξεχωριστό διαφανές φύλλο.   

 
Στα φύλλα μπορούμε να αποδώσουμε χαρακτηριστικά, όπως χρώμα και 

πάχος γραμμής.  Τα αντικείμενα που τοποθετούνται πάνω στα φύλλα 

μπορούν να υιοθετούν της ιδιότητες του κάθε φύλλου.  Μπορούμε να 

ελέγξουμε αν αυτά θα φαίνονται ή όχι, καθώς και αν θα εκτυπωθούν ή όχι.   

 
Τα φύλλα αυτά ονομάζονται Layers και αποτελούν ένα πολύ ισχυρό εργαλείο 

για τη δημιουργία και τροποποίηση των σχεδίων, καθώς και για την 

οργάνωση της εργασίας μας.  Κάθε σχέδιο περιέχει δικό του, ιδιαίτερο 

κατάλογο με Layers. 

 
Δημιουργούμε όσα Layers θέλουμε, δίνοντάς τους ονόματα που έχουν σχέση 

με τα αντικείμενα που θα τοποθετηθούν πάνω σ’αυτά (π.χ. Οικόπεδο, Τοίχος, 

Έπιπλο, Διάσταση κλπ). 

  
 

 
8. 1  ΟΜΑΔΑ ΕΡΓΑΛΕΙΩΝ OBJECT PROPERTIES 

 
 
Από όλα τα Layers που δημιουργούμε, μπορούμε να σχεδιάσουμε μόνο στο 

τρέχον (Current) Layer, που το όνομά του φαίνεται στην ομάδα εργαλείων 

Ιδιότητες Αντικειμένων (Object Properties Toolbar), στο πάνω αριστερό 

μέρος της οθόνης.  Στο τρέχον Layer τοποθετούνται μόνο τα νέα αντικείμενα 

που σχεδιάζουμε και όχι τα αντίγραφα παλαιών.  Όταν δημιουργούμε νέα 
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αντικείμενα αντιγράφοντας παλιά, αυτά υιοθετούν τις ιδιότητες, άρα και το 

Layer του πρωτότυπου αντικειμένου. 

 
Η εντολή LAYER εμφανίζει τον παρακάτω πίνακα.   

 
8. 2  O ΠΙΝΑΚΑΣ ΤΗΣ ΕΝΤΟΛΗΣ LAYER 

 
Αν πιέσουμε με το ποντίκι την ένδειξη Show details, παρουσιάζονται 

περισσότερες λεπτομέρειες, όπως στον επόμενο πίνακα: 
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8. 3  O ΠΙΝΑΚΑΣ ΤΗΣ ΕΝΤΟΛΗΣ LAYER ΜΕ ΛΕΠΤΟΜΕΡΕΙΕΣ
 

Όταν αρχίζουμε ένα νέο σχέδιο, αυτό περιέχει μόνο ένα Layer, το Layer 0, το 

οποίο δεν μπορούμε  ποτέ να καταργήσουμε.  Αυτό το Layer αρχικά έχει τις 

ακόλουθες ιδιότητες και ρυθμίσεις:   

 
ΙΔΙΟΤΗΤΑ 

ΑΡΧΙΚΗ 
ΡΥΘΜΙΣΗ 

ΤΟΥ LAYER 0 

 
ΠΕΡΙΓΡΑΦΗ 

On/Off 
    

 
 
 
 
 
 
 
 
 
 
 

On 
 
 
 
 
 
 
 
 
 
 
 
 

Η ιδιότητα αυτή ελέγχει την εμφάνιση του 
Layer.  Όταν ένα Layer είναι σβηστό (OFF), τα 
αντικείμενά του παραμένουν ενεργά μέρη του 
σχεδίου και υπολογίζονται από το πρόγραμμα 
σε οποιαδήποτε διαδικασία (Π.χ. κατά τη 
διάρκεια ενός Regeneration), αλλά δεν 
φαίνονται στην οθόνη  και δεν εκτυπώνονται.  
 
Μπορούμε να το ανάψουμε (ΟΝ) όποτε 
θέλουμε. Μπορούμε να σχεδιάσουμε πάνω σε 
ένα Layer που  είναι σβηστό, αλλά χρειάζεται 
ιδιαίτερη προσοχή, καθώς το αντικείμενο που 
σχεδιάζεται δεν φαίνεται στην οθόνη. 
 

Thaw/ 
Freeze 

       
 
 
 
 
 
 
 
 
 
 

Thawed 
 
 
 
 
 
 
 
 
 
 
 
 

Και αυτή η ιδιότητα ελέγχει την εμφάνιση  του 
Layer.  Όταν ένα Layer είναι παγωμένο 
(Frozen), παραμένει μέρος του σχεδίου, αλλά 
δεν φαίνεται  στην οθόνη και δεν εκτυπώνεται.  
Σε αντίθεση με την ιδιότητα ON/OFF, όμως, τα 
αντικείμενα του παγωμένου Layer Δεν 
υπολογίζονται σε μερικές λειτουργίες του 
προγράμματος (π.χ. κατά την αναγέννηση).  
 
 Μπορούμε να το ξεπαγώσουμε (Thaw) όποτε 
θέλουμε. Δεν μπορούμε να σχεδιάσουμε σε 
παγωμένο Layer και δεν μπορούμε να 
παγώσουμε το τρέχον Layer. 
 

Lock/ 
Unlock 

       
 
 
 
 
 
 
 
 
 

Unlocked 
 
 
 
 
 
 
 
 
 
 
 

Η ιδιότητα αυτή προστατεύει τα αντικείμενα 
του Layer κλειδώνοντάς τα.  Τη 
χρησιμοποιούμε όταν θέλουμε να βλέπουμε 
κάποια αντικείμενα στην οθόνη, αλλά δεν 
θέλουμε, κατά λάθος, να τα πειράξουμε με 
κάποια εντολή τροποποίησης.  O μηχανισμός 
Select Objects: δεν επιλέγει τα αντικείμενα 
ενός κλειδωμένου Layer.   
Μπορούμε να κλειδώνουμε (Lock) και να 
ξεκλειδώνουμε (Unlock) κατά βούληση. 
Μπορούμε να σχεδιάσουμε πάνω σε 
κλειδωμένο Layer. 

 67 



 
Color 
 
 
 
 
 
 
 
 
 

7 (White) 
 
 
 
 
 
 
 
 
 

Έχουμε τη δυνατότητα να αποδώσουμε 
χρώματα στα Layers.  
Τα αντικείμενα ενός Layer μπορούν να 
υιοθετούν το χρώμα του και να εμφανίζονται 
με αυτό στην οθόνη. Το χρώμα μας βοηθεί να 
ξεχωρίζουμε τα Layers μεταξύ τους για να μην 
κάνουμε λάθη κατά την τοποθέτηση των 
αντικειμένων στο σχέδιο. Αν προσπαθήσουμε 
να αλλάξουμε το χρώμα του Layer, 
εμφανίζεται το παρακάτω πλαίσιο:  

 
1 Red  (Κόκκινο) 
2 Yellow  (Κίτρινο) 
3 Green  (Πράσινο) 
4 Cyan  (Γαλάζιο) 
5 Blue  (Κυανό) 
6 Magenta  (Ματζέντα) 
7 White (ή Black αν η 

σχεδιαστική 
επιφάνεια είναι 
λευκή) 

 (Λευκό ή 
Μαύρο) 

 
Το πρόγραμμα διαθέτει 256 χρώματα (το 
τελευταίο είναι το χρώμα της σχεδιαστικής 
επιφάνειας).  Τα πρώτα 7 έχουν ονομασίες.  
Κατά κανόνα, τα αντικείμενα ενός Layer 
υιοθετούν το χρώμα του (έχουν χρώμα By 
Layer).  Αν αλλάξουμε το χρώμα του Layer, 
αλλάζουν ομαδικά και όλα τα αντικείμενά του.  
Μπορούμε όμως, κατ’ εξαίρεση, να 
διαφοροποιήσουμε κάποια αντικείμενα ως 
προς το χρώμα. 
 

Linetype 
 
 
 
 
 
 
 
 
 
 
 
 
 

Continuous 
 
 
 
 
 
 
 
 
 
 
 
 
 

Όπως και στο χρώμα, έχουμε τη δυνατότητα 
να αποδώσουμε σε κάποιο Layer την ιδιότητα 
του τύπου γραμμής – δηλαδή αν θα είναι η 
γραμμή του συνεχόμενη, διακεκομμένη, 
αξονική κλπ. 
 
Κατά κανόνα, τα αντικείμενα υιοθετούν το 
είδος γραμμής που έχει το Layer του (δηλαδή 
έχουν Linetype (By Layer).  Αν αλλάξουμε τον 
τύπο γραμμής ενός Layer, τότε αλλάζουν 
ομαδικά και όλα τα αντικείμενά του.  
Μπορούμε όμως, κατ’ εξαίρεση, να 
διαφοροποιήσουμε κάποια αντικείμενα ως 
προς το Linetype τους. 

Lineweight 
 

Default 
 

Το πάχος της γραμμής, με το οποίο θα 
σχεδιαστούν τα αντικείμενα, εξαρτάται από 
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την ιδιότητα Lineweight.  Μπορούμε να 
αποδώσουμε ένα πάχος γραμμής σε κάθε 
Layer.  Αν αλλάξουμε το πάχος γραμμής ενός 
Layer, εμφανίζεται ο παρακάτω πίνακας:  
 

  
 
Κατά κανόνα τα αντικείμενα ενός Layer 
υιοθετούν το πάχος γραμμής του.   Αν 
αλλάξουμε το Lineweight ενός Layer, 
αλλάζουν ομαδικά και όλα τα αντικείμενά του.  
Πολύ σπάνια διαφοροποιούμε το Lineweight 
ενός αντικειμένου  σε σχέση με το Layer του. 
 

Plot Style 
 
 
 
 
 
 

Normal  
 
 
 
 
 
 

Καθορίζει τον τρόπο εκτύπωσης ενός Layer, 
προσδιορίζοντας το χρώμα, το πάχος πένας, 
το ποσοστό μελανιού κλπ., για τη στιγμή της 
εκτύπωσης. Κατά κανόνα όλα τα αντικείμενα 
ενός Layer μπορούν να υιοθετούν τον ίδιο 
τρόπο εκτύπωσης, αλλά μπορούν, κατ’ 
εξαίρεση, να διαφοροποιηθούν. 
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8.1.3  Linetype 
 
Ο τύπος γραμμής που θα έχουν τα νέα αντικείμενα που σχεδιάζουμε 

ρυθμίζεται με την εντολή LINETYPE. 

 
 Command Line:  Linetype ┘ ή Ltype┘ ή Lt ┘ 
 Pull-down Menu:  Format → Linetype 
 
Ο πίνακας Select Linetypes μας επιτρέπει να επιλέξουμε οποιοδήποτε είδος 

γραμμής.  

 

 
8. 4  O ΠΙΝΑΚΑΣ ΕΠΙΛΟΓΗΣ ΤΥΠΩΝ ΓΡΑΜΜΩΝ 

 
8.1.5  Lineweight 
 
Το πάχος της γραμμής που θα έχουν τα νέα αντικείμενα, το οποίο 

σχεδιάζουμε, ρυθμίζεται εφεξής με την εντολή LINEWEIGHT. 

 
 Command Line:  Lineweight  ┘ή Lweight ┘ ή Lw ┘ 
 Pull-down Menu:  Format → Lineweight 
 
Ο πίνακας Lineweight Settings μας επιτρέπει να επιλέξουμε από ένα 

κατάλογο με διάφορα πάχη. 
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8. 5  Ο ΠΙΝΑΚΑΣ ΤΩΝ ΠΑΧΩΝ ΓΡΑΜΜΗΣ 

 
 
Lineweights 
 
 

Επιλέγουμε το τρέχον πάχος γραμμής από τον 
κατάλογο. 
 

Units for Listing 
 
 

Επιλέγουμε αν το πάχος γραμμής είναι σε χιλιοστά 
ή ίντσες. 
 

Display Lineweight 
 
 

Το ενεργοποιούμε αν θέλουμε να φαίνονται τα 
πάχη των γραμμών στην οθόνη. 
 

Default 
 

Προκαθορισμένο πάχος. 
 

Adjust Display Scale 
 

Καθορίζουμε το σχετικό πάχος όλων των γραμμών 
του σχεδίου.  Δεν έχει επίδραση στην εκτύπωση. 

 

 Το πλήκτρο LWT στη γραμμή κατάστασης ενεργοποιεί και 
απενεργοποιεί την εμφάνιση ή όχι του πάχος των γραμμών στην 
οθόνη. 

 
 
 

 
 
8.6  Ο ΔΙΑΚΟΠΤΗΣ ΕΜΦΑΝΙΣΗΣ ΤΟΥ ΠΑΧΟΥΣ ΓΡΑΜΜΩΝ ΣΤΗΝ ΟΘΟΝΗ 
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9 

 
 

ΕΝΤΟΛΕΣ 
ΠΛΗΡΟΦΟΡΙΩΝ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.   ΓΕΝΙΚΕΣ ΠΛΗΡΟΦΟΡΙΕΣ 

2. ΘΕΣΗ ΣΗΜΕΙΟΥ 

3. ΑΠΟΣΤΑΣΗ 

4. ΕΜΒΑΔΟΝ 
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Με τις εντολές πληροφοριών μπορούμε να αντλούμε στοιχεία για τα 

αντικείμενα και τις σχέσεις μεταξύ τους. 
 
9.1 ΓΕΝΙΚΕΣ ΠΛΗΡΟΦΟΡΙΕΣ  
 

  List  
 
Η εντολή LIST παρουσιάζει σε κατάλογο όλα τα δεδομένα για τα αντικείμενα 

που επιλέγουμε.  

 Command Line:  List ┘ ή Li┘  ή Ls ┘ 
 Pull-down Menu:  Tools  → Inquiry → List 
 
Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα: 
 

Command:  List ┘ 
Select objects:  Επιλέγουμε τα αντικείμενα. 
Select objects: 

  
Επιλέγουμε αντικείμενα ή πιέζουμε 
το┘        για να ολοκληρώσουμε την 
εντολή.  

 
Οι πληροφορίες παρουσιάζονται στο Text Window, ένα παράθυρο που 

περιέχει όλο το ιστορικό των εντολών, όπως είχε εμφανιστεί στη γραμμή 

εντολών.  Το παράθυρο ενεργοποιείται / απενεργοποιείται με το πλήκτρο F2. 

 
Ο κατάλογος των πληροφοριών είναι διαφορετικός  για κάθε είδος 

αντικειμένου.  Τα δεδομένα είναι για ανάγνωση μόνο και δεν αλλάζουν. 

 
9.2  ΘΕΣΗ ΣΗΜΕΙΟΥ 
 

  ID Point  
 
Η εντολή ID προσδιορίζει τις συντεταγμένες Χ,Υ,Ζ ενός σημείου.  

 Command Line:  Id ┘ ή  
 Pull-down Menu:  Tools → Inquiry → ID Point 
 
Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα: 
 

Command:  ID  ┘ 
Specify point:  Επιλέγουμε σημείο. 

X = 112.99     Y = 42.83     Z = 0.00 
 

Μας παρουσιάζει τις συντεταγμένες 
Χ,Υ,Ζ (στη δισδιάστατη σχεδίαση το 
Ζ=0). 
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Εναλλακτικά, μπορούμε, στο μήνυμα Specify point:, να πληκτρολογήσουμε 

τις συντεταγμένες ενός σημείου, οπότε θα εμφανιστεί ένα μικρό σημάδι (Blip) 

αν η Blipmode είναι ενεργοποιημένη και έτσι θα δούμε στην οθόνη τη θέση 

αυτού του σημείου.   

 
9.3  ΑΠΟΣΤΑΣΗ 
 

  Distance  
 
Η εντολή DISTANCE μετράει την απόσταση μεταξύ δύο σημείων.  

 Command Line:  Dist ┘ ή Di ┘ 
 Pull-down Menu:  Tools  →Inquiry → Distance 
 
Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα: 
 

Command:  Dist ┘ 
Specify first point:   Σημείο 1. 

Specify second point: Σημείο 2. 
 
Στη γραμμή εντολών βλέπουμε τα παρακάτω αποτελέσματα, για το 
συγκεκριμένο παράδειγμα: 

2

1

-4.00

-3.0
0

5.00
0°

217°

 
11. 1  ΟΙ ΠΛΗΡΟΦΟΡΙΕΣ ΠΟΥ ΔΙΝΟΝΤΑΙ ΜΕ ΤΗ DISTANCE 

Distance = 5.00,  Angle in XY Plane = 217,  Angle from XY Plane = 0 
Delta X = -4.00,  Delta Y = -3.00,   Delta Z = 0.00 
 
Distance Απόσταση μεταξύ των δύο σημείων:  5.00.  
Angle in XY Plane Κατεύθυνση από το Σημείο 1 προς το Σημείο 2:  217 

μοίρες. 
Angle from XY Plane Γωνία κλίσης  της γραμμής σε σχέση με το επίπεδο 

ΧΥ στο χώρο:  0 (για τρισδιάστατη σχεδίαση). 
Delta X Προβολή της απόστασης μεταξύ των δύο σημείων 

στον  άξονα Χ:  4.00. 
Delta Y Προβολή της απόστασης μεταξύ των δύο σημείων 

στον  άξονα Χ:  -3.00. 
Delta Z Προβολή της απόστασης μεταξύ των δύο σημείων 

στον  άξονα Ζ:  0. 
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9.4  ΕΜΒΑΔΟΝ 
 

  Area  
 
Η εντολή AREA υπολογίζει το εμβαδόν και την περίμετρο μίας περιοχής.  

Μπορούμε να περιγράψουμε την περιοχή με μία σειρά από σημεία ή να 

επιλέξουμε ένα αντικείμενο που περιβάλλει την περιοχή, π.χ. ένα κύκλο ή μία 

Polyline.  Μπορούμε να προσθέτουμε και να αφαιρούμε εμβαδά και το 

πρόγραμμα καταγράφει τα επιμέρους εμβαδά, καθώς και το γενικό σύνολο.  

 Command Line:  Area ┘ ή Aa ┘ 
 Pull-down Menu:  Tools  → Inquiry → Area 
 
Παράδειγμα:  Εμβαδομέτρηση κατοικίας. 
 

1 2

3 4

56
78

 
11. 2  ΕΜΒΑΔΟΜΕΤΡΗΣΗ ΜΕ ΣΗΜΕΙΑ 

Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα: 
Command:  Area ┘ 

Specify first corner point or 
[Object/Add/Subtract]: 

Σημείο 1. 
 

Specify next corner point or press 
ENTER for total: 

Σημείο 2. 
 

Specify next corner point or press 
ENTER for total: 

Σημείο 3. 
 

Specify next corner point or press 
ENTER for total: 

Σημείο 4. 
 

Specify next corner point or press 
ENTER for total: 

Σημείο 5. 
 

  Specify next corner point or press 
ENTER for total: 

Σημείο 6. 
 

Specify next corner point or press 
ENTER for total: 

Σημείο 7. 
 

Specify next corner point or press 
ENTER for total: 

Σημείο 8. 
 

Specify next corner point or press 
ENTER for total: 

┘ για να ολοκληρωθεί η εντολή. 
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Area = 18.80, Perimeter = 19.44 
 

Περιγράφει τα αποτελέσματα: 
Εμβαδόν = 18.80, Περίμετρος = 
19.44. 

 Total area = 8.52  Περιγράφει το τρέχον σύνολο. 
 (SUBTRACT mode) Select objects: Επιλέγουμε τον κύκλο 6. 

Area = 0.26, Circumference = 1.79  Εμβαδόν και περιφέρεια του κύκλου 
6. 

Total area = 8.27  Περιγράφει το γενικό σύνολο. 
 (SUBTRACT mode) Select objects: 

 
┘ (Για να σταματήσουμε να 
αφαιρούμε αντικείμενα). 

Specify first corner point or 
[Object/Add]: 

┘ (Για να ολοκληρώσουμε την 
εντολή). 

 76 



 

 

10 

ΣΥΝΘΕΤΕΣ ΕΝΤΟΛΕΣ ΣΧΕΔΙΑΣΗΣ ΚΑΙ ΕΠΕΞΕΡΓΑΣΙΑΣ 

 

 

 

 

 

 

 

 

1. ΔΙΑΓΡΑΜΜΙΣΗ 
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10.1  ΔΙΑΓΡΑΜΜΙΣΗ 
 
10.1.1    Hatch  
 
Η εντολή HATCH γεμίζει περιοχές με διαγράμμιση ή με ενιαίο χρώμα.  

Μπορούμε να υποδείξουμε την επιφάνεια που θέλουμε να διαγραμμίσουμε με 

ένα σημείο μέσα σε ένα κλειστό σχήμα.  Το πρόγραμμα μπορεί να εντοπίσει 

αυτόματα τα όρια της περιοχής, καθώς και τυχόν νησίδες που υπάρχουν στο 

εσωτερικό της. 

 
 Command Line:  Bhatch   ┘ ή H ┘  ή Bh┘  
 Pull-down Menu:  Draw → Hatch 
 
Εμφανίζεται ο παρακάτω πίνακας: 
 

 
10.3  Ο ΠΙΝΑΚΑΣ ΤΗΣ ΕΝΤΟΛΗΣ HATCH 

 
Type  Τύπος.  Ορίζουμε τον τύπο διαγράμμισης.  Αυτή μπορεί 

να είναι μία από τις προκαθορισμένες διαγραμμίσεις του 
προγράμματος ή μια δική μας. 

 
Pattern  Διαγράμμιση.  Επιλέγουμε προκαθορισμένη 

διαγράμμιση από ένα κατάλογο.  
 
Swatch   Δείγμα.  Αν πιέσουμε το δείγμα διαγράμμισης, 

εμφανίζεται ο παρακάτω πίνακας με τις προκαθορισμένες 
διαγραμμίσεις: 

 
10.1.1.1  Προκαθορισμένες Διαγραμμίσεις 
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10. 4  ΜΕΡΙΚΕΣ ΠΡΟΚΑΘΟΡΙΣΜΕΝΕΣ ΔΙΑΓΡΑΜΜΙΣΕΙΣ 

 

 Η διαγράμμιση τύπου Solid δημιουργεί συμπαγείς περιοχές.   
 
 
Custom Pattern Προσαρμοσμένες Διαγραμμίσεις.  Μπορούμε να 

επιλέξουμε μια διαγράμμιση από δικό μας αρχείο.  
 
Angle  Γωνία.  Ορίζουμε τη γωνία, σύμφωνα με την οποία θα 

σχεδιαστεί η διαγράμμιση. 
 
Scale  Κλιμάκωση.  Ορίζουμε την κλιμάκωση της διαγράμμισης.   

Iso Pen Width Πάχος Πένας.  Όταν έχουμε επιλέξει μια διαγράμμιση 
τύπου ISO, το πάχος των γραμμών προσαρμόζεται 
σύμφωνα με την κλιμάκωση της διαγράμμισης. 

 
Relative to Paper  Σχετικό με το Χώρο Χαρτιού. Προσαρμόζει την κλίμακα  
Space   της διαγράμμισης σε Paper Space.  Η  επιλογή 

ενεργοποιείται μόνο όταν χρησιμοποιούμε το μηχανισμό 
των  Layout για την παρουσίαση του τελικού σχεδίου. 

 
Pick Points  Καθορισμός Σημείων.  Επιλέγουμε ένα σημείο μέσα 

στην περιοχή που  θέλουμε να διαγραμμίσουμε.  Ο 
πίνακας εξαφανίζεται προσωρινά και στη γραμμή εντολών 
εμφανίζεται το μήνυμα: 
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Select internal point:   
 

Για να προσδιορίσουμε ένα 
σημείο μέσα στην περιοχή.   

Selecting everything 
visible. Analyzing the 

selected data. 

Το πρόγραμμα κάνει μία 
σύντομη ανάλυση του σχεδίου. 
 

Analyzing internal 
islands 

Εντοπίζει πιθανές νησίδες. 
 

Select internal point:  
 
 

Προσδιορίζουμε πρόσθετα 
σημεία ή  πιέζουμε    
επανέλθει ο πίνακας της 
εντολής. 

 
Select Objects Επιλογή Αντικειμένων.  Αντί για σημεία, επιλέγουμε 

κλειστά αντικείμενα (κύκλους, Polylines κλπ.) που 
θέλουμε να διαγραμμίσουμε.  Ο πίνακας εξαφανίζεται  και 
στη γραμμή εντολών εμφανίζεται το σύνηθες μήνυμα 
Select objects:.  Με το  επανέρχεται ο πίνα 

 
Remove Islands  Εξαίρεση Νησίδων.  Αν θέλουμε οι εσωτερικές νησίδες 

που εντοπίζονται να μην επηρεάσουν  τη διαγράμμιση, τις 
εξαιρούμε από τη διαδικασία.  Ο πίνακας εξαφανίζεται και 
στη γραμμή εντολών εμφανίζεται το μήνυμα: Select 
island to remove:  για να επιλέξουμε τις νησίδες που 
θέλουμε να εξαιρέσουμε.  Όταν έχουμε ολοκληρώσει την 
επιλογή, πιέζουμε το  καιεπαν    

 
View Selections  Παρουσίαση Επιλογών.  Κρύβει προσωρινά τον πίνακα 

και μας δείχνει τις επιλογές που έχουν γίνει. 
 
Inherit Properties  Αντιγραφή Ιδιοτήτων.  Μπορούμε να αντιγράψουμε τις 

ιδιότητες μίας  διαγράμμισης που υπάρχει ήδη στο 
σχέδιο. Ο πίνακας εξαφανίζεται προσωρινά και 
επιλέγουμε με το ποντίκι τη διαγράμμιση που θέλουμε να 
αντιγράψουμε.  Στη γραμμή εντολών εμφανίζονται τα εξής 
μηνύματα:  
 
Inherited Properties: Name <ANSI31>,     
 
Scale <0.05>, Angle <0> Πληροφορίες για τις ιδιότητες 

του αντικειμένου που επιλέξαμε. 
 
Select internal point:   Επιλέγουμε τις  περιοχές, στις 

οποίοες θα τοποθετηθεί η νέα διαγράμμιση ή 
πιέζουμε το  για να επανέλθει ο π 

 

 80 



Composition 
 

Associative Συσχετισμός.   Όταν είναι ενεργοποιημένο, 
δημιουργούμε διαγράμμιση που είναι ορισμένη σε 
σχέση με τα όριά της.  Όταν αλλάζουμε τη θέση 
των ορίων, η διαγράμμιση ακολουθεί τα νέα όρια. 

 
Nonassociative Ανεξάρτητο.   Όταν είναι ενεργοποιημένο, 

δημιουργούμε διαγράμμιση που είναι ανεξάρτητη 
από τα όριά της. 

 
Preview  Προεπισκόπηση.  Κάνει μία προεπισκόπηση της 

διαγράμμισης.   Αν δούμε κάτι που δεν είναι ικανοποιητικό 
στη διαγράμμιση, μπορούμε να πιέσουμε το  για να 
επανέλθει ο πίνακας και αλλάζουμε όποια ρύθμιση 
θέλουμε.  Μπορούμε να χρησιμοποιούμε το Preview 
όσες φορές θέλουμε μέχρι να διαμορφώσουμε την 
επιθυμητή διαγράμμιση. 

 
ΟΚ  Εφαρμόζει τη διαγράμμιση στο σχέδιο και ολοκληρώνει 

την εντολή.  
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11 

ΔΗΜΙΟΥΡΓΙΑ ΚΑΙ ΕΠΕΞΕΡΓΑΣΙΑ ΚΕΙΜΕΝΟΥ 

 

 

 

 

1. ΤΟΠΟΘΕΤΗΣΗ ΚΕΙΜΕΝΟΥ 
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11.1      Multiline Text 
 
Η  εντολή MULTILINE TEXT δημιουργεί κείμενα με ενιαίες παραγράφους.   

Μπορούμε, με το ποντίκι, να ορίσουμε το μέγιστο πλάτος του κειμένου.  Η  

γραφή γίνεται μέσω ενός κειμενογράφου του προγράμματος ή μέσω άλλων 

προγραμμάτων, όπως το Microsoft Word.  Η εντολή διαθέτει ιδιαίτερα  

ευέλικτα εργαλεία  μορφοποίησης και διόρθωσης του κειμένου. 

 
 Command Line:  Mtext ┘ ή Mt ┘ ή T  ┘ 
  Pull-down Menu:  Draw → Μultiline Text 
 
Στη γραμμή εντολών εμφανίζονται τα εξής μηνύματα:  
 

Command:  Mtext ┘ 
MTEXT Current text style:  

"Standard"  
 

Ενημέρωση για την τρέχουσα μορφή 
του κειμένου. 

Text height:  1.00 
 

Ενημέρωση για το τρέχον ύψος των 
γραμμάτων. 

Specify first corner: Πρώτη γωνία του παραθύρου. 
Specify opposite corner or 

[Height/Justify/ Line spacing/ 
Rotation/Style/ Width]: 

Δεύτερη γωνία του παραθύρου. 
 
 

 
Αμέσως εμφανίζεται ο πίνακας του επεξεργαστή κειμένου.   Αν θέλουμε, αντί 

να καθορίσουμε το δεύτερο σημείο του παραθύρου, μπορούμε να επιλέξουμε 

μία από τις παρακάτω ρυθμίσεις: 

Height Ορίζει το ύψος των γραμμάτων.   
Specify height <0.20>:  Πληκτρολογούμε την επιθυμητή τιμή. 

Justify Enter justification 
[TL/TC/TR/ML/MC/MR/BL/BC/BR] 

<TL>: 
 
 

Καθορίζει την τοποθέτηση και 
στοίχιση του κειμένου σε σχέση με το 
παράθυρο που έχουμε υποδείξει.  Το 
μήνυμα μας επιτρέπει να διαλέξουμε 
σημείο ελέγχου. 
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12 

 
 

ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗ 
 

 
 
 
 

 

 

 

 

 

1. ΤΟΠΟΘΕΤΗΣΗ ΔΙΑΣΤΑΣΕΩΝ 

2. ΜΟΡΦΕΣ ΔΙΑΣΤΑΣΕΩΝ 
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Παρά το γεγονός ότι τα θέματα σε ένα τεχνικό σχέδιο αποδίδονται σε κλίμακα, 

τοποθετούμε διαστάσεις για να βλέπουμε σημαντικές πληροφορίες χωρίς να 

μετρούμε με χάρακα.  Τα σχέδια στον τομέα της κατασκευής συνήθως 

απαιτούν πολλές διαστάσεις.  Δεν πρέπει να υποτιμούμε το χρόνο που 

χρειαζόμαστε για να τις δημιουργήσουμε.  

 
Το σχεδιαστικό μας πρόγραμμα διαθέτει εντολές για γρήγορη 

διαστασιολόγηση των μεγεθών, με απόλυτη ακρίβεια.   Οι διαστάσεις μπορεί 

να τοποθετηθούν στο σχέδιο σε οποιοδήποτε στάδιο και να το ακολουθούν 

καθώς αυτό αλλάζει. Οι διαστάσεις είναι σχεδιαστικά αντικείμενα, τα οποία 

αναπαράγονται και τροποποιούνται.   

 

 Η ακρίβεια των διαστάσεων εξαρτάται από την επιμέλεια του 
χρήστη κατά τη δημιουργία του σχεδίου. 

 
 
12.1  ΤΟΠΟΘΕΤΗΣΗ ΔΙΑΣΤΑΣΕΩΝ 

 

LINEAR

CONTINUOUS

ALIGNED

RADIAL

ANGULAR

DIAMETER

 
12. 1  ΒΑΣΙΚΑ ΕΙΔΗ ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗΣ 

 
Οι διαστάσεις αναπαριστούν γραμμικές αποστάσεις, μεγέθη καμπυλών και 

γωνίες.   
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12.1.1   Linear Dimension 
 
 
Ο πιο συνηθισμένη μορφή διαστασιολόγησης είναι η γραμμική. Η εντολή 

LINEAR DIMENSION δημιουργεί γραμμικές διαστάσεις, αφού 

προσδιορίσουμε δύο σημεία.   Μπορούμε να δείξουμε δύο ανεξάρτητα σημεία  

στο σχέδιο ή, αν πρόκειται για τις άκρες ενός αντικειμένου, μπορούμε να 

επιλέξουμε το αντικείμενο.  Το πρόγραμμα θα υπολογίσει αυτόματα το μήκος 

του. 

 
Αν διαστασιολογήσουμε μία γραμμή λοξή, η εντολή θα παραγάγει είτε την 

οριζόντια (παράλληλη με τον άξονα Χ) είτε την κατακόρυφη (παράλληλη με 

τον άξονα Υ) διάστασή της. 

X

Y

γραμμή

 
12. 2  ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗ ΛΟΞΗΣ ΓΡΑΜΜΗΣ ΜΕ ΤΗΝ ΕΝΤΟΛΗ LINEAR 

DIMENSION
 
 Command Line:  Dimlinear┘  ή Dimlin┘  ή Dli ┘ 
  Pull-down Menu:  Dimension → Linear 
 
Στη γραμμή εντολών εμφανίζονται τα παρακάτω μηνύματα: 
 

Command:  dimlinear  ┘ 
Specify first extension line origin 

or <select object>: 
Δείχνουμε το πρώτο σημείο 
αναφοράς (1). 
 

Specify second extension line 
origin: 

Δείχνουμε το δεύτερο σημείο 
αναφοράς (2). 

Specify dimension line location 
or[Mtext/Text/Angle/Horizontal/ 

Vertical/Rotated]: 

Δείχνουμε τη θέση της διάστασης (3). 
 
 

Dimension text = 6.00 Επιβεβαιώνει την τιμή. 
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1

2

3

1

2

 
12. 3  ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗ ΜΕ ΔΥΟ ΣΗΜΕΙΑ ΑΝΑΦΟΡΑΣ ΚΑΙ ΜΕ 

ΕΠΙΛΟΓΗ ΑΝΤΙΚΕΙΜΕΝΟΥ 
 

Αν θέλουμε να διαστασιολογήσουμε μία ενιαία γραμμή, μπορούμε να 

ακολουθήσουμε την παρακάτω διαδικασία: 

 
Command:  dimlinear  ┘ 

Specify first extension line origin 
or <select object>: 

┘ 
 

Select object to dimension: Δείχνουμε τη γραμμή (1). 
Specify dimension line location 
or[Mtext/Text/Angle/Horizontal/ 

Vertical/Rotated]: 

Δείχνουμε τη θέση της διάστασης (2). 
 
 

Dimension text = 6.00 Επιβεβαιώνει την τιμή. 
 
Όταν εμφανίζεται το μήνυμα  
 
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]:  έχουμε τις εξής 
επιπρόσθετες επιλογές: 
 
Horizontal Οριζόντια.  Δεσμεύει την εντολή να δημιουργήσει οριζόντια 

διάσταση. 
 
Vertical Κατακόρυφη.  Δεσμεύει την εντολή να δημιουργήσει 

οριζόντια διάσταση. 
 
Rotated 
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0°

γραμμή

90°

150°

(κλίση 150°)

 
12. 4  ΔΙΑΣΤΑΣΗ ΥΠΟ ΓΩΝΙΑ 

 
Υπό γωνία.  Δεσμεύει την εντολή να δημιουργήσει τη 
διάσταση όπως προβάλλεται υπό συγκεκριμένη γωνία.  

 
Mtext Κείμενο παραγράφου.  Αν θέλουμε, αντί για τον πραγματικό 

αριθμό, να γράψουμε άλλη τιμή ή φράση, μπορούμε να 
χρησιμοποιήσουμε τον πίνακα της εντολής Multiline Text.  Τα 
δύο σύμβολα « < > » αντιστοιχούν στην απόσταση που 
μετρήθηκε.  Μπορούμε να τη διατηρήσουμε προσθέτοντας 
κάποια λέξη πριν ή μετά την τιμή ή να σβήσουμε τα σύμβολα 
και να τα αντικαταστήσουμε με άλλα στοιχεία. 

 
Text Κείμενο.  Η επιλογή είναι παρόμοια με την προηγούμενη, με 

τη διαφορά ότι χρησιμοποιεί το μηχανισμό του Single Line 
Text για να αντικαταστήσει τον αριθμό.  Εμφανίζεται το 
μήνυμα:  Enter dimension text <1.00>:,  με το οποίο 
πληκτρολογούμε όποιον αριθμό ή κείμενο θέλουμε. 

 
Angle Κλίση κειμένου.  Καθορίζει την κλίση του κειμένου σύμφωνα 

με το σύστημα μέτρησης γωνιών.  Όταν βλέπουμε το μήνυμα 
Specify angle of dimension text:   πληκτρολογούμε την 
επιθυμητή γωνία. 

 
12. 5  ΚΛΙΣΗ ΚΕΙΜΕΝΟΥ 

 
 
 

 88 



12.1.2    Aligned Dimension 
 
Η εντολή ALIGNED DIMENSION δημιουργεί διαστάσεις παράλληλες προς το 

αντικείμενο ή την ευθεία που καθορίζουν δύο σημεία.  Η διαδικασία είναι ίδια 

με αυτή της Linear Dimension, αλλά το αποτέλεσμα είναι διαφορετικό, καθώς 

αναγράφεται η πραγματική απόσταση μεταξύ των δύο σημείων. 

 

 
12. 6  ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗ ΓΡΑΜΜΗΣ ΜΕ ΤΗΝ ΕΝΤΟΛΗ ALIGNED 

DIMENSION 

 Command Line:  Dimaligned ┘ ή Dimali ┘ ή Dal ┘ 
  Pull-down Menu:  Dimension → Aligned 
 
Η εντολή παρουσιάζει τα ίδια μηνύματα με αυτά της Linear Dimension, με 

εξαίρεση τις επιλογές Horizontal, Vertical και Rotated.  Χρειάζεται την ίδια 

διαδικασία με την προηγούμενη.  

 
 
12.1.5   Radius Dimension 
 
Η εντολή RADIUS DIMENSION διαστασιολογεί την ακτίνα ενός κύκλου ή 

τόξου. 

 Command Line:  Dimradius ┘ ή Dimrad  ┘ ή Dra ┘  
  Pull-down Menu:  Dimension → Radius 
 
Στη γραμμή εντολών εμφανίζονται τα παρακάτω μηνύματα: 
 

Command:  dimradius  ┘ 
Select arc or circle: Δείχνουμε τον κύκλο ή το τόξο (1). 

Dimension text = 0.90 Επιβεβαίωση ακτίνας. 
Specify dimension line location or 

[Mtext/Text/Angle]: 
Δείχνουμε τη θέση του αριθμού (2). 
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12. 7  ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗ ΑΚΤΙΝΑΣ ΚΑΙ ΔΙΑΜΕΤΡΟΥ 
 
12.1.6   Diameter Dimension 
 
Η εντολή DIAMETER DIMENSION διαστασιολογεί τη διάμετρο ενός κύκλου ή 

τόξου. 

 Command Line:  Dimdiameter ┘  ή Dimdia  ┘ ή Ddi  ┘ 
  Pull-down Menu:  Dimension  Dia m e te r 
 
Στη γραμμή εντολών εμφανίζονται τα παρακάτω μηνύματα: 
 

Command:  dimradius  ┘ 
Select arc or circle:  Δείχνουμε τον κύκλο ή το τόξο (1). 

Dimension text = 1.80  Επιβεβαίωση διαμέτρου. 
Specify dimension line location or 

[Mtext/Text/Angle]: 
Δείχνουμε τη θέση του αριθμού (2). 
 

 
 
12.1.7   Angular Dimension 
 
Η εντολή ANGULAR DIMENSION διαστασιολογεί την περιεχόμενη γωνία ενός 

κύκλου ή τόξου, τη γωνία μεταξύ δύο γραμμών ή τη γωνία που σχηματίζεται 

ανάμεσα σε μία κορυφή και δύο σημεία. 

 
 Command Line:  Dimangular   ┘ή Dimang  ┘ ή Dan  ┘ 
  Pull-down Menu:  Dimension → Angular 
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24

ΚΥΚΛΟ Η ΤΟΞΟ ΔΥΟ ΓΡΑΜΜΕΣ ΚΟΡΥΦΗ ΚΑΙ ΔΥΟ ΣΗΜΕΙΑ

 
12. 8  ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗ ΓΩΝΙΑΣ 

Στη γραμμή εντολών εμφανίζονται τα παρακάτω μηνύματα: 
 
Κύκλος ή τόξο: 
 

Command:  dimangular  ┘ 
Select arc, circle, line, or <specify 

vertex>: 
Επιλέγουμε τον κύκλο ή το τόξο (1). 

Specify dimension arc line location 
or [Mtext/Text/Angle]: 

Δείχνουμε τη θέση της διάστασης 
(2). 
 

Dimension text = 160 Επιβεβαίωση της τιμής. 
 
Δύο γραμμές: 
 

Command:  dimangular  ┘ 
Select arc, circle, line, or <specify 

vertex>: 
Επιλέγουμε την πρώτη γραμμή (1). 

Select second line: Επιλέγουμε τη δεύτερη γραμμή (2). 
Specify dimension arc line location 

or [Mtext/Text/Angle]: 
Δείχνουμε τη θέση της διάστασης 
(3). 
 

Dimension text = 160 Επιβεβαίωση της τιμής. 
 
Κορυφή και δύο σημεία: 
 

Command:  dimangular  ┘ 
Select arc, circle, line, or <specify 

vertex>: 
 για να επιλέξουμε κορυφή. 

Specify angle vertex: Προσδιορίζουμε το σημείο της 
κορυφής (1). 

Specify first angle endpoint: Το πρώτο σημείο της γωνίας (2). 
Specify second angle endpoint: Το δεύτερο σημείο της γωνίας (3). 

Specify dimension arc line location 
or [Mtext/Text/Angle]: 

Δείχνουμε τη θέση της διάστασης (4). 
 

Dimension text = 44 Επιβεβαίωση της τιμής. 
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12.9  ΔΙΑΣΤΑΣΙΟΛΟΓΗΣΗ ΜΙΚΡΗΣ ΚΑΙ ΜΕΓΑΛΗΣ ΓΩΝΙΑΣ 

12.1.10   Center Mark 
 
Όταν γράφουμε διαστάσεις που αναφέρονται σε ένα κέντρο κύκλου ή τόξου, 

συχνά επισημαίνουμε το κέντρο του με ένα σταυρό.  H εντολή CENTER 

MARK τοποθετεί ένα σταυρό στο κέντρο ενός κύκλου ή τόξου.   Αν 

ρυθμίσουμε κατάλληλα τη λειτουργία των διαστάσεων, η ίδια εντολή μπορεί 

να τοποθετεί και τέσσερις πρόσθετες αξονικές γραμμές.  

 

12. 10  ΕΠΙΣΗΜΑΝΣΗ ΚΕΝΤΡΟΥ ΜΕ ΤΗΝ ΕΝΤΟΛΗ CENTER MARK 
 
 Command Line:  Dimcenter  ┘ ή Dce  ┘ 
  Pull-down Menu:  Dimension → Center Mark 
 
Η εντολή απλά μας ζητεί να επιλέξουμε το αντικείμενο και αμέσως τοποθετεί 

το σταυρό. 

12.2  ΜΟΡΦΕΣ ΔΙΑΣΤΑΣΕΩΝ (DIMENSION STYLES) 

Οι διαστάσεις είναι σύνθετα αντικείμενα και επιδέχονται ρυθμίσεις σε πολλά 

χαρακτηριστικά τους.  Το πρόγραμμα συγκροτεί τα στοιχεία, που αποτελούν 

τις διαστάσεις, σε ανώνυμα Blocks.  Μπορούμε να τα διασπάσουμε με την 

εντολή Explode, αλλά αυτό δεν συνιστάται, καθώς δύσκολα θα έχουμε τον 

έλεγχό τους.  Είναι τόσο πολλές και λεπτομερείς οι αλλαγές που μπορούμε να 

κάνουμε σε μία διάσταση, ώστε δεν χρειάζεται να τη διασπάσουμε.    
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DIMENSION LINE
(γραμμή διάστασης)

EXTENSION LINE
(γραμμή επέκτασης)

ΤΕΧΤ (κείμενο)

ARROWHEADS (βέλη)

DEFINITION POINTS
(σημεία αναφοράς)

 

12.11  ΤΑ ΜΕΡΗ ΤΗΣ ΔΙΑΣΤΑΣΗΣ 
 
Η παραπάνω μορφή της διάστασης με τα τρίγωνα βέλη και τις γραμμές 

επέκτασης είναι η αρχική μορφή των διαστάσεων, όπως καθορίζεται από το 

πρόγραμμα.  Μπορούμε να αλλάξουμε τη μορφή των γραμμάτων, των βελών 

και των μεγεθών τους.  Έχουμε τη δυνατότητα να παραλείψουμε τις γραμμές 

διάστασης ή επέκτασης, καθώς και να διαφοροποιήσουμε τα χρώματα ή τον 

τύπο γραμμής των διαφόρων στοιχείων. 

 
 Dimension Style 

 
Με την εντολή DIMENSION STYLE έχουμε τη δυνατότητα να δημιουργήσουμε 

πολλές μορφές διαστάσεων και να τις αποθηκεύσουμε για μελλοντική χρήση.    

 
Μετά την παρουσίαση των παραμέτρων της εντολής, θα εξετάσουμε ένα 

παράδειγμα, στο οποίο θα δημιουργήσουμε μία μορφή διαστασιολόγησης 

που χρησιμοποιείται σε πολλά τεχνικά γραφεία.   

 
 Command Line:  Dimstyle  ┘ ή D  ┘ 
  Pull-down Menu:  Dimension  → Style 
 

 93 



 

12.12  Ο ΠΙΝΑΚΑΣ ΔΙΑΧΕΙΡΙΣΗΣ ΤΩΝ ΜΟΡΦΩΝ ΔΙΑΣΤΑΣΕΩΝ 
 
Σε κάθε μορφή διαστάσεων δίνουμε ένα όνομα. Ο κατάλογος της εικόνας 

περιέχει τρία Dimension Styles. Η αρχική μορφή ονομάζεται ISO-25.  Είναι 

καλύτερο να μην αλλάζουμε τη μορφή του αρχικού Style.  Μπορούμε να 

αντιγράψουμε την ISO-25 και να δημιουργήσουμε μία ή περισσότερες μορφές.  

Στη συνέχεια μπορούμε να αλλάξουμε τα χαρακτηριστικά του δικού μας 

Dimension Style, σύμφωνα με τις προτιμήσεις μας και τις απαιτήσεις του 

σχεδίου.   

New Νέα.  Η ένδειξη New του παραπάνω πίνακα δημιουργεί 
νέα μορφή διάστασης.  Στον επόμενο πίνακα 
πληκτρολογούμε το όνομα της νέας μορφής και 
επιλέγουμε τη μορφή που θα αντιγράψουμε.  

 

 

12. 13  Ο ΠΙΝΑΚΑΣ ΟΝΟΜΑΣΙΑΣ ΝΕΑΣ ΜΟΡΦΗΣ ΔΙΑΣΤΑΣΕΩΝ 
New Style Name Νέο όνομα.  Στο πεδίο αυτό  πληκτρολογήσαμε το 

όνομα ΑΡΧΙΤΕΚΤΟΝΙΚΑ για να δημιουργήσουμε μία 
νέα μορφή διαστάσεων για τα αρχιτεκτονικά μας 
σχέδια.   

Start With Αρχή με...  Επιλέγουμε μια υπάρχουσα μορφή 
διαστάσεων που θέλουμε να αντιγράψουμε.  

 
Use for Χρήση...  Μπορούμε να δημιουργήσουμε μία γενική 

μορφή για να τη χρησιμοποιήσουμε σε όλους τους 
τύπους διαστάσεων ή να δημιουργήσουμε μία 
εξειδικευμένη μορφή, π.χ. μόνο για ακτίνες.  Στον 
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πίνακα μας επιλέγουμε την All dimensions (Για 
όλες τις διαστάσεις) για να δημιουργήσουμε μία 
γενική μορφή.   

 
Continue Συνέχεια.  Κλείνει τον πίνακα και εμφανίζει τον 

πίνακα  των χαρακτηριστικών της νέας μορφής. 
 

Set Current Τρέχουσα.  Ορίζει ότι η μορφή διαστάσεων που έχουμε 
επιλέξει θα γίνει η τρέχουσα και οι επόμενες διαστάσεις 
θα δημιουργηθούν με αυτή τη μορφή. 

 
Modify Τροποποίηση.  Τροποποιεί τη μορφή διάστασης που 

έχουμε επιλέξει. 
 
Override Διαφοροποίηση.  Εμφανίζει τον πίνακα 

διαφοροποιήσεων για να καθορίσουμε προσωρινές 
παραλλαγές σε σχέση με τη γενική καθορισμένη μορφή. 
Ο πίνακας είναι ίδιος σε εμφάνιση και λειτουργία σε σχέση 
με το βασικό πίνακα καθορισμού μορφής.  Ο πίνακας και 
όλες οι ενότητές του περιγράφονται αναλυτικά παρακάτω. 

 
Compare Σύγκριση.  Συγκρίνει τα χαρακτηριστικά ανάμεσα σε δύο 

διαφορετικές μορφές ή παρουσιάζει κατάλογο με όλα τα 
χαρακτηριστικά μίας μόνο μορφής.  Στον παρακάτω 
πίνακα συγκρίνουμε τις ιδιότητες των μορφών 
ΑΡΧΙΤΕΚΤΟΝΙΚΑ και ISO-25. 

 

 
12. 14  Ο ΠΙΝΑΚΑΣ ΣΥΓΚΡΙΣΗΣ ΜΟΡΦΩΝ ΔΙΑΣΤΑΣΕΩΝ 

Παράμετροι Μορφών Διαστάσεων 

Μπορούμε να διαμορφώσουμε τα παρακάτω χαρακτηριστικά των 

διαστάσεων: 

• Τις γραμμές και τα βέλη. 
  
• Τη μορφή του κειμένου. 
  
• Την προσαρμογή των στοιχείων κατά την εφαρμογή. 
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• Τις κύριες και εναλλακτικές μονάδες. 
  
• Τις ανοχές τους. 
 
Κάθε κατηγορία χαρακτηριστικών έχει δικό της πίνακα ελέγχου.  Τα ονόματα 

των κατηγοριών εμφανίζονται στο πάνω μέρος του πίνακα. 

 
12.2.1 Lines and Arrows Γραμμές και Βέλη.   Στον παρακάτω πίνακα 

ρυθμίζουμε τις γραμμές διάστασης, τις γραμμές 
επέκτασης, τα βέλη και τους σταυρούς των 
κύκλων. 

 

12. 15  Η ΕΝΟΤΗΤΑ ΓΡΑΜΜΕΣ ΚΑΙ ΤΑ ΒΕΛΗ 
Dimension Lines Γραμμές Διαστάσεων.  Η κύρια γραμμή της 

διάστασης έχει τη δυνατότητα να αλλάξει σύμφωνα 
με τα παρακάτω χαρακτηριστικά: 

 
 

Color 
 
 

Καθορίζουμε το χρώμα της γραμμής σε 
σχέση με την υπόλοιπη διάσταση. 
 

Lineweight 
 

Καθορίζουμε το πάχος της γραμμής σε 
σχέση με την υπόλοιπη διάσταση. 

Extend beyond ticks 

EXTEND
BEYOND
TICKS

 
12. 16  EXTEND BEYOND 

TICKS 

Καθορίζουμε την προεξοχή της γραμμής 
πέρα από τη γραμμή επέκτασης, αν έχουμε 
επιλέξει βέλη Architectural Tick ή 
Oblique. 
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SPACING
BASELINE

 
12. 17  BASELINE SPACING 

Baseline Spacing 
 
 

 

Καθορίζουμε την απόσταση που θα έχουν 
οι διαστάσεις μεταξύ τους, όταν 
χρησιμοποιούμε την εντολή Baseline 
Dimension. 

Suppress 1 and 2 
 

 
12. 18 SUPPRESS 1 AND 

2 

Καθορίζουμε την εξάλειψη ή όχι του 
τμήματος της γραμμής διάστασης, που 
αντιστοιχεί στο πρώτο και στο δεύτερο 
σημείο αναφοράς. 
 
 
 
 
 
 
 

 
Extension Lines Οι γραμμές επέκτασης της διάστασης ελέγχονται 

με τους παρακάτω τρόπους: 
 
Color 
 
 

Καθορίζουμε το χρώμα της γραμμής σε 
σχέση με την υπόλοιπη διάσταση. 
 

Lineweight 
 
 

Καθορίζουμε το πάχος της γραμμής σε 
σχέση με την υπόλοιπη διάσταση 
 

Extend beyond dim lines 
 
 

Καθορίζουμε το μέγεθος επέκτασης της 
γραμμής πάνω από τη γραμμή διάστασης. 
 

 97 



EXTEND
BEYOND
DIM LINES

OFFSET
FROM 
ORIGIN

 
12. 19  EXTEND BEYOND DIM LINES ΚΑΙ OFFSET FROM ORIGIN 

 Offset from origin  
 
 
 

Καθορίζουμε  πόσο μακριά από το 
αντικείμενο θα αρχίζουν οι γραμμές 
επέκτασης.  
 

 Suppress 1 and 2 

 
12. 20  SUPPRESS 1 AND 2 

Καθορίζουμε την εξάλειψη ή όχι της 
γραμμής επέκτασης που αντιστοιχεί στο 
πρώτο και δεύτερο σημείο αναφοράς. 
 
 
 
 
 
 

 

Arrowheads Βέλη.  Καθορίζουμε τη μορφή του βέλους.  
Μπορούμε, εκτός από τα έτοιμα βέλη του 
προγράμματος, να σχεδιάσουμε ένα δικό μας και 
να το ομαδοποιήσουμε σε Block.   

 

 

12. 21  ΜΟΡΦΕΣ ΒΕΛΩΝ 

1st  
 

 

Καθορίζουμε τη μορφή του βέλους στο 
πρώτο σημείο αναφοράς. 
 

2nd 

 
Καθορίζουμε τη μορφή του βέλους στο 
δεύτερο σημείο αναφοράς. 

Leader 
 
 

Καθορίζουμε τη μορφή του βέλους στο 
δείκτη. 
 

 98 



Arrow size 
 

Καθορίζουμε  το μέγεθος του βέλους.  
 

 

 Οι περισσότεροι χρήστες του προγράμματος προτιμούν να 
χρησιμοποιήσουν δικό τους Block για το βέλος.  Αυτό συμβαίνει 
επειδή στα κατασκευαστικά σχέδια συνηθίζουμε να κρύβουμε τις 
γραμμές επέκτασης.  Χωρίς αυτές όμως, κανένα βέλος δεν 
δημιουργεί και μία κάθετη γραμμή.  Σχεδιάζουμε ένα σταυρό, στον 
οποίο η κάθε γραμμή έχει μήκος 2 μονάδες.  Πάνω στο σταυρό 
τοποθετούμε ένα σχήμα, όπως το θέλουμε (λοξή γραμμή, κύκλο 
κλπ).  Τέλος, ομαδοποιούμε τα στοιχεία σε Block με σημείο βάσης 
το κέντρο του σταυρού.   Στον κατάλογο με τα βέλη, μπορούμε να 
επιλέξουμε το User Arrow και να διαλέξουμε το Block μας από τον 
κατάλογο. 

 
 

Center Marks for Circles Καθορίζουμε τη μορφή και το μέγεθος του 
σταυρού στο κέντρο ενός κύκλου ή τόξου.  

 
Type 
 
 

Καθορίζει τη μορφή του σταυρού στους 
κύκλους. 
 

None 
 

Καθορίζουμε να μην εμφανίζεται σταυρός. 
 

Mark 

 
12.22 MARK 

 

Καθορίζουμε να  εμφανίζεται σταυρός. 
 
 
 
 
 
 
 

Line 
 

 
12. 23  LINE 

Καθορίζουμε να εμφανίζονται και σταυρός 
και γραμμές. 
 
 
 
 
 
 
 
 

Size Καθορίζουμε το μέγεθος του σταυρού. 

 
Text  Κείμενο.  Ο παρακάτω πίνακας ρυθμίζει την εμφάνιση και 

τη θέση του κειμένου της διάστασης. 
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12. 24  H ENOTHTA TOY KEIMENOY 
Text Appearance Καθορίζει την εμφάνιση των γραμμάτων και τη 

θέση του κειμένου σε σχέση με τη διάσταση. 
 
Text style 
 
 

Καθορίζουμε τη μορφή του κειμένου των 
διαστάσεων. 
 

Text color 
 

Καθορίζουμε το χρώμα του κειμένου σε 
σχέση με την υπόλοιπη διάσταση. 
 

Text height  
 

Καθορίζουμε το ύψος των γραμμάτων.   
 

Fraction height scale 
 
 
 

Αν χρησιμοποιούμε κλάσματα, καθορίζουμε 
το ύψος του κλάσματος σε σχέση με το 
κείμενο.  
 

Draw frame around text 

 
12. 25  DRAW FRAME 
AROUND TEXT 

Καθορίζουμε αν θα σχεδιάζεται ένα πλαίσιο 
γύρω από το κείμενο. 
 
 
 
 
 
 
 
 

 
Text Placement Καθορίζουμε τη θέση του κειμένου σε σχέση με τη 

γραμμή. 
 
Vertical 
 

Καθορίζει την κατακόρυφη θέση του 
κειμένου. 

Centered  Τοποθετεί το κείμενο αξονικά πάνω στη 
γραμμή. 
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12. 26  CENTERED 

 
 
 

Above 

 

12. 27  ABOVE 

Τοποθετεί το κείμενο πάνω από τη γραμμή 
διάστασης. 
 
 
 
 

Outside 

 

12. 28  OUTSIDE 

Τοποθετεί το κείμενο στην αντίθετη πλευρά 
της γραμμής διάστασης, σε σχέση με το 
πρώτο σημείο αναφοράς. 
 
 
 
 
 
 
 

JIS 
 

Ακολουθεί το Ιαπωνικό Πρότυπο 
διαστασιολόγησης. 

Horizontal Καθορίζει την οριζόντια θέση του κειμένου. 

Centered 

 

12. 29  CENTERED 

Τοποθετεί το κείμενο στο κέντρο της 
γραμμής διάστασης. 
 
 
 
 

At Ext Line 1 

 

12. 30  AT EXTENSION LINE 1 

Τοποθετεί το κείμενο στην πλευρά του 
πρώτου σημείου αναφοράς. 
 
 
 
 

At Ext Line 2 

 

12. 31  AT EXTENSION LINE 2 

Τοποθετεί το κείμενο στην πλευρά του 
δεύτερου σημείου αναφοράς. 

Over Ext Line 1 

 

Τοποθετείται παράλληλα και κοντά στην 
πρώτη γραμμή επέκτασης. 
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12. 32  OVER 1ST 
EXTENSION LINE 

 

Over Ext Line 2 

  

12. 33  OVER 2ND 
EXTENSION LINE 

Τοποθετείται παράλληλα και κοντά στη 
δεύτερη γραμμή επέκτασης. 
 
 
 
 
 

Offset from  dim line  

OFFSET
FROM
DIM LINE

 

Καθορίζει την απόσταση που θα έχει το 
κείμενο από τη γραμμή διάστασης. 
 
 
 
 
 
 
 
 
 
 

 
Text Alignment Προσανατολισμός Κειμένου.  Καθορίζουμε τον 

προσανατολισμό του κειμένου σε σχέση με τη γραμμή 
διάστασης, δηλαδή αν θα είναι μέσα ή έξω από τη 
διάσταση. 

 
Horizontal 

 
12. 34   HORIZONTAL 

Τοποθετεί το κείμενο πάντα οριζόντιο. 
 
 
 
 
 

Aligned with dimension line 

 
12. 35  ALIGNED 

Προσανατολίζει το κείμενο σύμφωνα με τη 
γραμμή διάστασης. 
 
 
 
 
 

ISO standard Προσανατολίζει το κείμενο σύμφωνα με τη 
γραμμή διάστασης όταν είναι μέσα στη 
διάσταση, αλλά το γράφει οριζόντιο όταν 
είναι έξω από τη διάσταση. 
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Fit Προσαρμογή.  Στον παρακάτω πίνακα, καθορίζουμε τη 
θέση των βελών, του κειμένου, του δείκτη και της 
γραμμής διάστασης. 

 

 

12. 36  H ENOTHTA FIT 
Fit Options Επιλογές Προσαρμογής.  Καθορίζουμε τον τρόπο 

προσαρμογής των στοιχείων της διάστασης όταν οι 
αποστάσεις που διαστασιολογούμε είναι πολύ 
μικρές και δεν χωρούν ανάμεσα στις γραμμές 
επέκτασης.  Όταν δεν επαρκεί ο χώρος, το πρώτο 
πράγμα που θα μετακινηθεί έξω από τη διάσταση 
είναι: 

 
Either the Text or the Arrows, 
Whichever Fits Best  
 

Είτε το κείμενο είτε τα βέλη, ανάλογα με το 
ποιο ταιριάζει καλύτερα.  
 

Arrows 
 

Τα βέλη.  
 

Text 
 

Το κείμενο.  
 

Both Text and Arrows 
 

Και το κείμενο και τα βέλη. 
 

Always Keep Text Between 
Ext Lines 
 

Πάντα διατηρεί το κείμενο μέσα στη 
διάσταση. 
 

Suppress Arrows If They 
Don't Fit Inside Extension 
Lines 

Εξαλείφει τα βέλη αν δεν χωρούν μέσα στη 
διάσταση. 
 

 
Text Placement Θέση Κειμένου.  Ρυθμίζει τη θέση του κειμένου 

όταν πρέπει να μετακινηθεί έξω από τις γραμμές 
επέκτασης. 

 
Beside the Dimension Line Τοποθετεί το κείμενο δίπλα στη γραμμή 

διάστασης. 
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12. 37  BESIDE THE 
DIMENSION LINE 

 
 
 
 
 

Over the Dimension Line, 
with a Leader 

 

12. 38  LEADER 

Τοποθετεί το κείμενο πάνω από τη γραμμή 
διάστασης, με ένα δείκτη. 
 
 
 
 
 
 
 

Over the Dimension Line, 
Without a Leader 

 

12. 39  NO LEADER 

Τοποθετεί το κείμενο πάνω από τη γραμμή 
διάστασης, χωρίς δείκτη. 
 
 
 
 
 

 
Scale for Dimension Features  Ρυθμίζει τη γενική κλίμακα των 

διαστάσεων. 

OVERALL 
SCALE =1

OVERALL 
SCALE =2

OVERALL 
SCALE =0.5

 
Use overall scale of 
 

Ο γενικός συντελεστής μεγέθους των 
διαστάσεων.  
 

Scale dimensions to a layout 
(paperspace) 
 

Ρυθμίζει τα μεγέθη των διαστάσεων για να 
συμφωνούν με μία διάταξη εκτύπωσης 
(Layout). 

Fine Tuning Λεπτομερής ρύθμιση. 

Place Text Manually When 
Dimensioning 
 

Αν ενεργοποιήσουμε αυτή την επιλογή, 
δείχνουμε την οριζόντια θέση του κειμένου 
καθώς τοποθετούμε τη διάσταση. 
 

Always Draw Dim Line Αν ενεργοποιήσουμε αυτή την επιλογή, θα 
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Between Ext Lines 
 
 
 

τοποθετεί πάντα μια γραμμή διάστασης 
ανάμεσα στις γραμμές επέκτασης, ακόμη 
και σε πολύ μικρές διαστάσεις. 
 

 
 
Primary Units Κύριες Μονάδες.  Στον παρακάτω πίνακα 

καθορίζουμε την εμφάνιση των μονάδων 
διάστασης, την ακρίβεια και τα συμπληρωματικά 
στοιχεία του κειμένου. 

 

 
12. 40  H ENOTHTA PRIMARY UNITS 

Linear Dimensions Γραμμικές Διαστάσεις.  Εδώ ρυθμίζουμε τη 
μορφή και την ακρίβεια των γραμμικών διαστάσεων. 

 
Unit Forma 
 
 
 
t 

Προσδιορίζουμε τη μονάδα μέτρησης για 
όλες τις διαστάσεις, εκτός από τις γωνίες.  
Συνηθίζουμε να επιλέγουμε τη Decimal 
(δεκαδική μορφή). 
 

Precision 

 

12. 41  PRECISION 

Καθορίζουμε τον αριθμό των δεκαδικών 
ψηφίων που θα γραφτούν στις διαστάσεις. 
 
 
 
 
 
 
 

Fraction Format Καθορίζουμε τη μορφή, με την οποία θα 
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παρουσιάζονται τα κλάσματα.  Αν έχουμε 
επιλέξει τη δεκαδική μορφή για τους 
αριθμούς, η επιλογή αυτή είναι 
απενεργοποιημένη. 
 

Decimal Separator 
 1.20 
1,20 
1 20 

 

Καθορίζουμε το σύμβολο που θα 
χρησιμοποιήσουμε για να χωρίζουμε τα 
δεκαδικά ψηφία.  Οι επιλογές είναι  η τελεία 
(.), το κόμμα (,), ή ένα κενό. 

Round Off 
 

1.2345 = 1.25 
 
 
 

Καθορίζουμε τη στρογγυλοποίηση του 
αριθμού της διάστασης.  Για παράδειγμα, 
αν πληκτρολογήσουμε την τιμή 0.05, το 
πρόγραμμα θα στρογγυλοποιεί όλες τις 
τιμές ανά πέντε εκατοστά. 
 

Prefix 
 
 

~1.00 
 
 

Καθορίζουμε το κείμενο που θέλουμε να 
εμφανίζεται πάντα πριν από τον αριθμό.  
Για παράδειγμα, αν πληκτρολογήσουμε το 
σύμβολο ~, τότε η διάσταση για ένα μέτρο 
θα γράφει ~1.00. 
 

Suffix 
1.00 μ. 

Καθορίζουμε το κείμενο που θέλουμε να 
εμφανίζεται πάντα μετά από τον αριθμό.  
Για παράδειγμα, αν πληκτρολογήσουμε το 
γράμμα μ., τότε η διάσταση για ένα μέτρο 
θα γράφει 1.00 μ. 
 

Measurement Scale Ρύθμιση συντελεστών. 

Scale Factor: 
 

1.5 Χ 2 = 3.00 
 
 
 
 

Καθορίζουμε ένα συντελεστή, με τον οποίο 
θα πολλαπλασιάζουμε πάντα το 
αποτέλεσμα της μέτρησης.  Αν, για 
παράδειγμα, πληκτρολογήσουμε 2, η 
διάσταση για ένα αντικείμενο με μήκος 1.50 
θα γράφει 3.00. 
 

Apply to Layout Dimensions 
Only:   
 
 

Εφαρμόζει την παραπάνω ρύθμιση μόνο 
στις διαστάσεις που εφαμόζονται σε μία 
διάταξη εκτύπωσης (Layout). 
 

Zero Suppression Εξάλειψη μηδενικών. 

Leading:   
 

0.50 = .50 
 

Καθορίζουμε την εξάλειψη ή μη των 
αρχικών μηδενικών.  Για παράδειγμα, η 
τιμή 0.50 γίνεται .50. 
 

Trailing:   
0.50 = 0.5 

 

Καθορίζουμε την εξάλειψη ή μη των 
τελικών μηδενικών.  Για παράδειγμα, η τιμή 
0.50 γίνεται 0.5. 

 106 



  
0 Feet:   
 

Καθορίζουμε την εξάλειψη του μηδενικού 
στη μέτρηση με πόδια.   
 

0 Inches:    
 
 

Καθορίζουμε την εξάλειψη του μηδενικού 
στη μέτρηση με ίντσες. 
 

 
Angular Dimensions  Γωνιακές διαστάσεις. 
 

Units Format 
 
 
 
 

Καθορίζουμε τη μορφή των μονάδων 
μέτρησης γωνιών.  Συνηθίζουμε να 
επιλέγουμε τη Decimal Degrees (Μοίρες σε 
δεκαδική μορφή). 
 

Precision 
 
 
 

Καθορίζουμε την ακρίβεια ή τον αριθμό των 
δεκαδικών ψηφίων που θα γραφτούν στις 
γωνίες. 
  

Zero Suppression 
 

Εξάλειψη μηδενικών.  
 

Leading:   
 

Καθορίζουμε την εξάλειψη ή μη των 
αρχικών μηδενικών. Για παράδειγμα, η τιμή 
0.50 γίνεται .50. 

Trailing:   
 
 

Καθορίζουμε την εξάλειψη ή μη των 
τελικών μηδενικών.   Για παράδειγμα, η 
τιμή 0.50 γίνεται 0.5. 
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ΕΚΤΥΠΩΣΗ 
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Αφού ολοκληρώσουμε ένα σχέδιο στον υπολογιστή, πρέπει να το 

εκτυπώσουμε σε χαρτί, δηλαδή να παραγάγουμε το τελικό προϊόν της 

εργασίας μας.   

 

Μπορούμε να εκτυπώσουμε το σχέδιό μας σε εκτυπωτή μικρό (printer), σε 

ιδιαίτερα μεγάλο ειδικό για σχέδια (plotter) ή να παραγάγουμε ένα αρχείο, το 

οποίο εκτυπώνεται σε υπολογιστή που δεν διαθέτει το ίδιο σχεδιαστικό 

πρόγραμμα με το δικό μας.   

 
  Plot 

 
 Command Line:  Plot┘ ή Print ┘ 
  Pull-down Menu:  File → Plot 
 

Πριν επιχειρήσουμε να εκτυπώσουμε το σχέδιό μας, είναι σκόπιμο να 

κάνουμε ένα τελικό έλεγχο στις ιδιότητες που έχουμε αποδώσει στα 

αντικείμενα, καθώς και στην κατάσταση των Layers (On/Off, Freeze/Thaw, 

Plot/NoPlot), για να εξασφαλίσουμε ότι θα εκτυπωθεί το σχέδιο μόνο με τις 

πληροφορίες που επιθυμούμε. 

 
Η εκτύπωση του σχεδίου είναι μία διαδικασία που περιλαμβάνει τη ρύθμιση 

πολλών παραμέτρων.   Αυτές προσφέρουν ιδιαίτερη ευελιξία για την επίτευξη 

του καλύτερου δυνατού τελικού αποτελέσματος. 

 

Γενικά, έχουμε τη δυνατότητα να επιλέξουμε: 

• τον εκτυπωτή, ανάμεσα σε αυτούς που έχουν εγκατασταθεί στο σύστημα 

μας. 

• την απόδοση χαρακτηριστικών, όπως χρώμα και πάχος γραμμής, που θα 

έχουν τα αντικείμενα του σχεδίου. 

• το μέγεθος του φύλλου χαρτιού, στο οποίο θα γίνει η εκτύπωση. 

• τον προσανατολισμό και την τοποθέτηση του σχεδίου στο χαρτί. 

• την κλίμακα του σχεδίου. 

• το μέρος του σχεδίου που θα εκτυπώσουμε. 
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Η εντολή της εκτύπωσης περιλαμβάνει δύο γενικές ομάδες ρυθμίσεων:  την 

ενότητα Plot Device και την ενότητα Plot Settings.   

 

13.1  Plot Device 

Η ενότητα Plot Device ελέγχει τη λειτουργία του εκτυπωτή, ενώ η ενότητα Plot 

Settings την τελική εμφάνιση του σχεδίου. 

13.2  Plot Settings 

Η ενότητα Plot Settings ρυθμίζει δεδομένα, όπως την κλίμακα και τον 

προσανατολισμό του σχεδίου. 

 
13.2.1  Paper Size 
 
Επιλέγουμε το μέγεθος του φύλλου χαρτιού που θα τοποθετήσουμε στον 
εκτυπωτή. 
 
Εκτός από τα γνωστά μεγέθη χαρτιού A0 μέχρι Α1, υπάρχουν και τα 
αντίστοιχα μεγέθη Oversize A0 μέχρι Oversize Α1, τα οποία έχουν ένα 
πρόσθετο περιθώριο γύρω από τα γνωστά μεγέθη.  Για παράδειγμα, το 
Oversize A3 έχει καθαρή εκτυπώσιμη επιφάνεια Α3 και ένα περιθώριο, για να 
το συγκρατεί ο εκτυπωτής.    
 
13.2.2  Drawing Orientation 
 
Καθορίζουμε τον προσανατολισμό της εκτύπωσης. 
 
13.2.3  Plot Area 
 
Καθορίζουμε το μέρος του σχεδίου, το οποίο θα εκτυπώσουμε. 
 
Limits 
 
 

Εκτυπώνουμε το σχέδιο μέχρι τα όριά του, όπως τα έχουμε 
καθορίσει με την εντολή Drawing Limits. 
 

Extents 
 

Εκτυπώνουμε το σχέδιο μέχρι τα όρια των αντικειμένων του. 
 

Display 
 
 

Εκτυπώνουμε την Περιοχή του σχεδίου, η οποία φαίνεται στην 
οθόνη. 
 

View 
 
 

Εκτυπώνουμε την άποψη, την οποία έχουμε αποθηκεύσει με 
την εντολή View. 
 

Window 
 
 

Προσδιορίζουμε ένα παράθυρο για να εκτυπώσουμε μια 
περιοχή μικρότερη από αυτή που φαίνεται στην οθόνη. 
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13.2.4  Plot Scale 
 
Καθορίζουμε την κλίμακα εκτύπωσης.  Επιλέγουμε μία κλίμακα από τον 
κατάλογο ή συμπληρώνουμε τα δύο πεδία Custom.  Οι αριθμοί αντιστοιχούν 
χιλιοστά με μονάδες σχεδίασης.  Ο παρακάτω πίνακας εμφανίζει αντιστοιχίες 
τιμών για τις συνηθέστερες κλίμακες, όταν σχεδιάζουμε με μονάδες μέτρησης 
ενός μέτρου: 
 
ΚΛΙΜΑΚΑ ΜΜ DRAWING UNITS 
1:1 1000 1 
1:2 1000 2 
1:5 1000 5 
1:10 1000 10 
1:20 1000 20 
1:50 1000 50 
1:100 1000 100 
1:200 1000 200 
1:500 1000 500 
1:1000 1000 1000 
 
 
13.2.5  Plot offset 
 
X, Y 
 
Η εκτύπωση αρχίζει στο κάτω αριστερό σημείο του σχεδίου.  Μπορούμε να 
μετατοπίσουμε την αρχή της εκτύπωσης σε χιλιοστά κατά τον άξονα Χ και τον 
άξονα Υ. 
 
Center the plot 
 
Τοποθετεί το σχέδιο στο κέντρο του χαρτιού. 
 
13.3  Γενικές Ρυθμίσεις 
 
13.3.1  Partial Preview 
 
Η επιλογή Partial Preview (Μερική Προεπισκόπηση) παρουσιάζει την 
τοποθέτηση του σχεδίου πάνω στο χαρτί και ελέγχει αν επαρκεί η επιφάνεια 
του χαρτιού, για να χωρέσει το σχέδιο στη δεδομένη κλίμακα.   
 
Το λευκό περίγραμμα αντιπροσωπεύει το φύλλο του χαρτιού και η γαλάζια 
περιοχή είναι η έκταση του σχεδίου.  Το κόκκινο τρίγωνο αντιπροσωπεύει την 
αρχή της εκτύπωσης. 
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13. 1  PARTIAL PREVIEW 

 
13.3.2  Full Preview 
 
Η επιλογή Full Preview (Πλήρης Προεπισκόπηση) λειτουργεί όπως και η 
Partial Preview, αλλά εμφανίζει το σχέδιο με όλες του τις λεπτομέρειες.  Οι 
γραμμές σχεδιάζονται με τα τελικά χρώματα και πάχη εκτύπωσης. 
 

 
13. 2  FULL PREVIEW 

13.3.3  Save changes to layout 
 
Αν είναι ενεργοποιημένη, οι ρυθμίσεις της εκτύπωσης αποθηκεύονται μαζί με 
το σχέδιο για μελλοντικές εκτυπώσεις. 
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Page setup name 
 
Εμφανίζει ένα κατάλογο με αποθηκευμένες ρυθμίσεις εκτυπώσεων για το ίδιο 
σχέδιο. 
 
Add 
 
Προσθέτει τις τρέχουσες ρυθμίσεις στον κατάλογο Page setup name. 
 
 
Παράδειγμα:  Εκτύπωση ασπρόμαυρου σχεδίου 58 Χ 40 εκατοστών σε 
χαρτί Α1 με κλίμακα 1:50 σε Plotter . 
 
1. Αρχίζουμε την εντολή Plot. 
 
2. Στην ενότητα Plot Device, επιλέγουμε τον plotter από τον κατάλογο 

Plotter Configuration.  
 
3. Στον κατάλογο Plot Style Tables, επιλέγουμε είτε το monochrome.stb ή 

το monochrome.ctb.  Αυτοί οι πίνακες αντιστοιχούν το μαύρο χρώμα σε 
όλα τα αντικείμενα του σχεδίου, ενώ όλα τα υπόλοιπα χαρακτηριστικά 
δίνονται από τις ιδιότητες των αντικειμένων μέσα στο σχέδιο. 

 
4. Στην ενότητα Plot Settings και στην ένδειξη Paper Size, επιλέγουμε ένα 

φύλλο χαρτιού μεγέθους ISO A1 σε διάταξη Landscape. 
 
5. Στην περιοχή Plot Area, επιλέγουμε την ένδειξη Extents για να 

εκτυπώσουμε όλα τα αντικείμενα του σχεδίου. 
 
6. Στην περιοχή Plot Scale στα πεδία Custom, πληκτρολογούμε τους 

αριθμούς 1000 και 50. 
 
7. Στην περιοχή Plot Offset, ενεργοποιούμε την ένδειξη Center the plot για 

να τοποθετήσουμε το σχέδιο στο κέντρο του φύλλου. 
 
8. Επιλέγουμε την ένδειξη Full Preview για να έχουμε προεπισκόπηση της 

εκτύπωσης.  Πιέζουμε το  ┘για να φύγουμε από την προεπισκόπηση. 
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13. 3  ΤΟ ΣΧΕΔΙΟ ΣΤΟ ΚΕΝΤΡΟ ΤΟΥ ΧΑΡΤΙΟΥ 

 
9. Τοποθετούμε το χαρτί στο Plotter και πιέζουμε το ΟΚ για να εκτυπωθεί 

το σχέδιο. 
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ΠΑΡΑΡΤΗΜΑ   1 
 
 
 
 
 
 
 
 
 
 
 

ΣΧΕΔΙΑΣΗ ΙΣΟΓΕΙΑΣ ΠΕΤΡΙΝΗΣ ΚΑΤΟΙΚΙΑΣ  
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Το  πρόγραμμα Autocad ενεργοποιείται  κάνοντας διπλό κλικ πάνω 

στην επιφάνεια εργασίας της οθόνης. Σ 
την οθόνη μας εμφανίζεται το πεδίο λειτουργίας του προγράμματος. 

Αυτό αποτελείται από το πεδίο σχεδιασμού, μία γραμμή από μενού( File, Edit, 
κλπ) και διάφορες μπάρες από συντομεύσεις εντολών. Όλες οι εντολές που 
εμφανίζονται στα μενού υπάρχουν και στις μπάρες με τις συντομεύσεις. Στο 
κάτω μέρος της οθόνης εμφανίζεται μία μπάρα στην οποία μπορούμε να 
γράψουμε τις εντολές από το πληκτρολόγιο και κάτω αυτή υπάρχει μία 
γραμμή, στην  οποία αναφέρονται οι απόλυτες συντεταγμένες του σταυρού 
που υπάρχει στην οθόνη, και οχτώ (8) συντομεύσεις εντολών. 

Όταν εκκινεί την λειτουργία του το πρόγραμμα πάντοτε ξεκινάει με την 
εμφάνιση ενός παράθυρου, μέσω του οποίου επιλέγουμε: 

♦ Εάν ξεκινάμε ένα καινούργιο σχέδιο 
♦ Να ανοίξουμε ένα ήδη υπάρχων σχέδιο  
♦ Να επιλέξουμε από την βάση δεδομένων του προγράμματος τι 

ακριβώς θέλουμε να σχεδιάσουμε  
Μπορεί επίσης να ξεκινήσουμε το πρόγραμμα  ανοίγοντας απευθείας 

το σχέδιο το οποίο επιθυμούμε, είτε αυτό είναι στον υπολογιστή είτε στην 
δισκέτα. 

Από εδώ και πέρα γίνεται μία περιληπτική αναφορά και επεξήγηση στις 
εντολές που χρησιμοποιούνται κατά κόρον στο σχεδιασμό δυσδιάστατων 
σχεδίων. 
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  ΜΕΝΟΥ FILE 
New : Ανοίγει καινούργιο αρχείο του Autocad για να σχεδιάσουμε. 
 
Θέλουμε να σχεδιάσουμε  ένα ισόγειο πέτρινο σπίτι διαστάσεων 
10,00 χ5,00 μ.  
εντολή OSNAP (έλξεις) 

ΜΕΝΟΥ DRAW : 
Εντολή    Line  10  ┘ 
ενεργοποιούμε την εντολή ortho που μας βοηθά να κρατάμε τις καθετότητες. 
                  Line 5 ┘ 
                  Line  10  ┘ 
                  Line 5 ┘ 
 
σχεδιάσαμε τον εξωτερικό τοίχο .Ομοίως   σχεδιάζουμε τον εσωτερικό τοίχο 
πάχους 0,50  μ.   
 
 

 
 
 
 
Σχεδιάζουμε τα ανοίγματα πόρτες και παράθυρα. 
Δεξιά άκρη     Line  1  ┘ 
                       Line  0.5  ┘ 
                       Line  1 .20  ┘ 
                       Line  0.5   ┘ 
 
Ομοίως   σχεδιάζουμε τα υπόλοιπα ανοίγματα. 
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 Σχεδιάζουμε τα παράθυρα  και με την εντολή MOVE και ROTATE τα 
τοποθετούμε στα ανοίγματα με τη βοήθεια των έλξεων. 
 
 

 
 
 
 
επειδή οι διαστάσεις είναι οι πραγματικές ,μέσο της εντολής DIMENSION 
STYLE μορφοποιούμε τον τρόπο με τον οποίο εμφανίζονται οι διαστάσεις. 
LINES AND ARROWS         oblique 
Καθορίζουμε πως θα είναι οι γραμμές διαστάσεων και τα βέλη τέλους αυτών. 
TEXT: το ύψος των αριθμών  0.2 
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 Σχεδιάζουμε τους εσωτερικούς τοίχους με τα ανοίγματα. 
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ΜΕΝΟΥ DIMENSION 
Εντολή   Linear dimension  τοποθετούμε τις διαστάσεις  
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ΜΕΝΟΥ DRAW :MULTILANE TEXT   

 
 

 
 
 
 
 
 
στο παράθυρο που έχουμε είναι ένας κειμενογράφος όπου καθορίζουμε, 
ανάλογα με την κλίμακα  ,το ύψος των γραμμάτων 0.50. 
Με την εντολή ED μπορούμε να κάνουμε τυχόν αλλαγές και διορθώσεις.  
Γράφουμε   ΚΑΤΟΨΗ  ΙΣΟΓΕΙΟΥ  . 
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Το επόμενο σχέδιο είναι η όψη. 
 

 
 
 
 
 
ΜΕΝΟΥ DRAW : 

Εντολή    Line  10  ┘ 
ενεργοποιούμε την εντολή ortho που μας βοηθαει να κρατάμε τις 
καθετότητες. 
                  Line 0.5 ┘ 
                  Line  10  ┘ 
                  Line 0.5 ┘ 
 
                  Line    3  ┘ 
                  Line   10  ┘ 
                  Line    3 ┘ 
ομοίως σχεδιάζουμε πόρτες και παράθυρα και  στέγη. 
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ΜΕΝΟΥ DRAW :    MULTILANE TEXT  γράφουμε τη λέξη ΠΡΟΣΟΨΗ 
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Εντολή  HATCH  επιλέγουμε pattern AR-816 
            SCALE   1.00    SELECT OBJECTS  
            PREVIEW  , ENTER.και δημιουργήσαμε την πέτρα. Ομοίως την στέγη. 
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ΜΕΝΟΥ DRAW : 
Εντολή    Line  10  ┘ 
ενεργοποιούμε την εντολή ortho που μας βοηθά  να κρατάμε τις καθετότητες. 
                  Line 0.5 ┘ 
                  Line  10  ┘ 
                  Line 0.5 ┘ 
 
                  Line    3  ┘ 
                  Line   10  ┘ 
                  Line    3 ┘ 
ομοίως σχεδιάζουμε πόρτες και παράθυρα και  στέγη. 
ΜΕΝΟΥ DIMENSION 
 
              Εντολή   Linear dimension  τοποθετούμε τις διαστάσεις  
 
ΜΕΝΟΥ DRAW : 
               MULTILANE TEXT   γράφουμε τη λέξη ΤΟΜΗ 
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                              ΠΑΡΑΡΤΗΜΑ 2 

 
 
 
 
 
 
 

ΣΧΕΔΙΑ ΚΑΤΟΨΗΣ-ΟΨΗΣ-ΤΟΜΗΣ ΙΣΟΓΕΙΟΥ 
ΚΑΤΟΙΚΙΑΣ  
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ΠΑΡΑΡΤΗΜΑ 3 
 
 
 
 
 

ΣΧΕΔΙΟ ΤΟΠΟΓΡΑΦΙΚΟ 
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                                            ΟΡΟΛΟΓΙΑ 
 
Startup Εκκίνηση 
Screen Οθόνη Σχεδίασης 
Mouse Ποντίκι 
New Νέο 
Open Άνοιγμα 
Quick Save Γρήγορη Αποθήκευση 
Save Αποθήκευση 
Save As Αποθήκευση με Όνομα 
Close Κλείσιμο 
Exit Έξοδος 
Command Line Γραμμή Εντολών 
Pull-Down Menu Πτυσσόμενο Μενού 
Toolbars Ομάδες Εργαλείων 
Shortcut Menus Σύντομα Μενού 
Line Γραμμή 
Circle Κύκλος 
Undo Αναίρεση 
Redo Επαναφορά Εντολής 
Ortho Ορθογώνια Κίνηση 
Cartesian Coordinates, 
absolute 

Καρτεσιανές Συντεταγμένες, απόλυτες 

Cartesian Coordinates, 
relative 

Καρτεσιανές Συντεταγμένες, σχετικές 

Polar Coordinates, absolute Πολικές Συντεταγμένες, απόλυτες 
Polar Coordinates, relative Πολικές Συντεταγμένες, σχετικές 
Direct Distance Entry Άμεση Εισαγωγή Απόστασης 
Object Snaps Σημεία Έλξης 
Running Object Snaps Μόνιμα Σημεία Έλξης 
Endpoint Τέλος  
Midpoint Μέσο  
Intersection Τομή  
Apparent Intersection Εμφανής Τομή 
Extension Επέκταση 
Center Κέντρο 
Quadrant Τεταρτοκύκλιο 
Tangent Εφαπτομένη 
Perpendicular Κάθετος 
Parallel Παράλληλος 
Node Κόμβος 
Insert Σημείο Εισαγωγής 
Nearest Πλησιέστερο 
None Κανένα 
From Σημείο Αναφοράς 
Object Snap Tracking Περασιές 
Polar Tracking Δέσμευση ποντικιού σε γωνία 
Units Μονάδες 
Drawing Limits Περιοχή Σχεδίασης 
Snap Βήμα 
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Grid Κάναβος 
Coords Συντεταγμένες 
Zoom Αλλαγή εικόνας 
Zoom Window Παράθυρο 
Zoom Previous Προηγούμενο 
Zoom Extents Μέγιστο 
Zoom All Στα Όρια 
Zoom Center Στο Κέντρο 
Zoom Dynamic Δυναμικό 
Zoom In Προς τα μέσα 
Zoom Out Προς τα έξω 
Zoom Realtime Σε αληθινό χρόνο 
Zoom Scale Υπό κλίμακα 
Pan Μετακίνηση εικόνας 
Aerial View Βοηθητικό Παράθυρο Απεικόνισης 
Redraw Καθάρισμα Οθόνης 
Regeneration Αναγέννηση Σχεδίου 
Viewports Παράθυρα Οθόνης 
Named Views Αποθήκευση Άποψης 
Erase Διαγραφή 
Oops Αναίρεση Διαγραφής 
Select Objects Επιλογή Αντικειμένων 
Select Objects Pick Ατομικά 
Select Objects Window Με Απλό Παράθυρο 
Select Objects Crossing Με Παράθυρο Τομής 
Select Objects Window 
Polygon 

Με Πολύγωνο 

Select Objects Crossing 
Polygon 

Με Πολύγωνο Τομής 

Select Objects Fence Με Τεθλασμένη Γραμμή 
Select Objects Last Τελευταίο 
Select Objects Previous Προηγούμενα 
Select Objects Add Προσθήκη 
Select Objects Shift Προσθήκη με Shift 
Select Objects Undo Αναίρεση Επιλογής 
Select Objects All Όλα 
Select Objects Remove Αφαίρεση 
Group Ομάδα 
Preselect Προεπιλογή 
Cycling Κυκλική Επιλογή 
Qselect Γρήγορη Επιλογή 
Move Μετακίνηση 
Copy Αντιγραφή 
Rotate Περιστροφή 
Scale Μεγέθυνση 
Offset Παράλληλα Αντίγραφα 
Mirror Συμμετρικά Αντίγραφα 
Mirrtext Καθρεφτισμός Κειμένων 
Trim Κοπή Αντικειμένων 
Extend Επέκταση Αντικειμένων 
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Fillet Στρογγυλοποίηση Γωνίας 
Chamfer Απότμηση Γωνίας 
Stretch Τέντωμα 
Array Αντιγραφή σε Διάταξη 
Align Ευθυγράμμιση 
Lengthen Αλλαγή Μήκους 
Break Αφαίρεση Τμήματος 
Grips Λαβές 
Arc Τόξα 
Polyline Πολυγραμμές 
Explode Διάσπαση 
Pedit Τροποποίηση Πολυγραμμής 
Polyline Edit Τροποποίηση Πολυγραμμής 
Ellipse Έλλειψη 
Rectangle Ορθογώνιο 
Polygon Πολύγωνο 
Donut Κυκλική Πολυγραμμή 
Point Σημείο 
Point Style Μορφή  Σημείου 
Construction Line Ευθεία 
Ray Ημιευθεία 
Layers Φύλλα Σχεδίασης 
Color Χρώμα 
Linetype Τύπος Γραμμής 
Ltscale Κλίμακα Τύπων Γραμμής 
Lineweight Πάχος Γραμμής 
Object Properties Ιδιότητες Αντικειμένων 
Linetype Scale Κλίμακα Τύπων  Γραμμής (ιδιότητα) 
Match Properties Αντιγραφή Ιδιοτήτων 
List Γενικές Πληροφορίες 
ID Point Πληροφορία για Συντεταγμένες Σημείου 
Distance Απόσταση 
Area Εμβαδόν 
Hatch Διαγράμμιση 
Hatch Edit Τροποποίηση Διαγράμμισης 
Solid Συμπαγής Περιοχή 
Spline Καμπύλη 
Spline Edit Τροποποίηση Καμπύλης 
Multiline Πολλαπλή Γραμμή 
Multiline Style Μορφή Πολλαπλών Γραμμών 
Multiline Edit Τροποποίηση Πολλαπλών Γραμμών 
Imageattach Εισαγωγή Εικόνας 
Image Διαχείριση Εικόνων 
Imageadjust Ρύθμιση Εικόνας 
Imagequality Ποιότητα Εικόνας 
Transparency Διαφάνεια Εικόνας 
Imageclip Περιορισμός Έκτασης Εικόνας 
Draworder Σειρά Απεικόνισης Αντικειμένων 
Single Line Text Κείμενο σε Ανεξάρτητη Σειρά 
Multiline Text Κείμενο σε Παραγράφους 
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Mtexted Αλλαγή Επεξεργαστή Κειμένου 
Modify Text Τροποποίηση Κειμένου 
Find and Replace Εντοπισμός και Αντικατάσταση Κειμένου 
Text Style Μορφές Κειμένου 
Block Make Δημιουργία Συμβόλου 
Wblock Αποθήκευση Συμβόλου σε Διαδρομή 
Insert Block Εισαγωγή Συμβόλου 
Base Αλλαγή Σημείου Βάσης 
Divide Διαίρεση  
Measure Μέτρηση 
Define Attributes Καθορισμός Πληροφοριών Συμβόλου 
Single Attribute Edit  Τροποποίηση Πληροφορίας Συμβόλου 
Global Attribute Edit  Τροποποίηση Πολλαπλών Πληροφοριών 

Συμβόλου 
Redefine Attribute  Αλλαγή Καθορισμού Πληροφορίας 

Συμβόλου 
Attach External Reference  Σύνδεση Εξωτερικού Αρχείου 
External Reference 
Manager 

Διαχείριση Εξωτερικών Αρχείων 

Xbind Σύνδεση Στοιχείου από Εξωτερικό Αρχείο 
In-Place Xref and Block Edit Επιτόπου Αλλαγή Συμβόλου  
Dimension Linear Γραμμική Διάσταση 
Dimension Aligned Παράλληλη Διάσταση 
Dimension Continued Συνεχόμενες Διαστάσεις 
Dimension Baseline Διαστάσεις με Κοινή Αφετηρία 
Dimension Radius Ακτίνα 
Dimension Diameter Διάμετρος 
Dimension Angular Γωνία 
Ordinate Dimension Συντεταγμένες 
Qdim Γρήγορη Διαστασιολόγηση 
Center Mark Σταυρός σε Κέντρο 
Leader Δείκτης 
Dimension Style Μορφή Διαστάσεων 
Dimension Update Ενημέρωση Μορφής Διαστάσεων 
Dimension Edit Τροποποίηση Διαστάσεων 
Dimension Text Edit Τροποποίηση Κειμένου Διαστάσεων 
Plot Εκτύπωση 
Plotter Configuration Ρύθμιση του εκτυπωτή 
Plot Device Λειτουργία του εκτυπωτή 
Plot Style Tables Μορφές Εκτύπτωσης 
Plot Settings Παράμετροι Εκτύπωσης του Σχεδίου 
Plot Scale Κλίμακα Εκτύπωσης 
Partial Preview Μερική Προεπισκόπηση 
Full Preview Πλήρης Προεπισκόπηση 
Multiple Drawings Πολλαπλά Σχέδια 
Cut Διαγραφή και αποθήκευση στο Clipboard 
Copy Αποθήκευση στο Clipboard 
Paste Επικόλληση στο Clipboard 
Copy Link Αποθήκευση  μιας άποψης στο Clipboard 
Copy with Base Point Αποθήκευση στο Clipboard με σταθερό 
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σημείο 
Drag’n’Drop Άμεση Μεταφορά με το Ποντίκι 
Paste to Original 
Coordinates 

Επικόλληση στις Αρχικές Συντεταγμένες 

Paste as Block Επικόλληση στο Clipboard σαν Σύμβολο 
DesignCenter Μηχανισμός για Μοίρασμα Στοιχείων 

Σχεδίων 
Purge Καθάρισμα Σχεδίου από Άχρηστα 

Στοιχεία 
Partial Open Μερικό Άνοιγμα 
Partial Load Μερικό Φόρτωμα 
Template Drawings Υπόβαθρα 
Options Προτιμήσεις 
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